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GSSCORE

PROGRAMME
HIGHLIGHTS

1. Our well designed test papers will focus on testing concepts as
well as factual knowledge as per UPSC Pattern.
. Total 39 Tests:
a. Fundamental Tests - 14
b. Revision Tests (including Current Affairs) - 9
c. Economic Survey + Budget + IYB - 1
d. Mock Tests-15

Sub-sectional Tests: Under this each subject will be divided in
sub-topics to bring more depth in preparation. These tests will be
of 700 Questions each.

Revision Tests (RT) : Under this each subject mentioned in the
UPSC syllabus & Current Affairs will be catered and each test will
consist of 700 Questions.

Mock Tests: Mock tests will be conducted on UPSC pattern. Paper7
will consist of 100 Qs. and Paper 2 will consist 80 Qs.

. 3-Layer Performance Analysis including Test Report, Detailed
Analysis & integrated All India Ranking for Online & Classroom
Aspirants.
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FAQ

» What is this program all about?

» PRELIMS CRT 2020 is designed to achieve MAXIMUM SCORE in Prelims 2020 through
Speed and Accuracy in solving MCQs which plays the most VITAL role in 2 hrs of prelims
examination.

PRELIMS CRT 2020 will help in covering Subjects from NCERT to ADVANCE level on
WEEKLY basis which enhances the understanding of concepts and inter-connectivity
between them.

Programme will help in organising the preparation which is very important because due
to late start and unorganised study aspirants lag behind and fail in Prelims exam by 2-3
marks.

This program is designed to help students in Quick Revision; otherwise, they may be lost
in the vast ocean of data and information overload.

» How is it different from other test series?
Self-Study and regular REVISION is the key to Holistic Preparation.
Our PRELIMS CRT 2020 will cover each subject in a holistic manner.

This will help students prepare each subject extensively as well as intensively.

|
>
» Each subject will be covered rigorously.
>
>

Programme will test one’s knowledge and preparation for prelims rigorously.

» How to use this Programme?
» Through our PRELIMS CRT students will solve 3600* MCQs with detailed explanations.

» Detailed explanations will help in covering multiple dimensions of the topics in syllabus in
stipulated time and full efficiency.

» Explanation with Smart solution will help in learning the art of elimination as it is not feasible
for an aspirant to know everything under the sun. The art of eliminating options is the key to
solve those questions where students lack sufficient information asked in the exam.

PRELIMS COMPLETE REVISION TESTS
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TEST SCORE ANALYSIS

Attempted
Analysis

@ Attempt

Ideal time to solve the question
Know where you have made a silly mistake/fluke

Learn to catch the key words, such as steadily, All,
incorrect

TEST
REPORT

ANALYSIS

_ Total Questions
— (Correct
Incorrect

Know your
performance

0-0-0-0

Strength  Weakness  Opportunity Threat
(your strong  (your weak  (based on smart (Trap or
area) area) solution) Silly mistake)

1.Your Answer Perfect Attempt

Overtime Attempt
2.Correct Answer Waste Attempt

3.Attempt Review Casual Attempt

2 Level

Solutions
/Explanation

m

1.Traditional How to eliminate

Optimum strategy based on
2.Smart Calculated risk

DETAILED
ANALYSIS

You

v/s

Toppers

ANALYSIS

Question
Stats

1. Question wise analysis

2. Where you stand

3. Vis a vis topper (time taken by you v/s Topper)
4. You v/s peer group

)
)
)
)

1. Topic from where question has been asked

2. Sub topic Level 1: Factual
3. Difficulty level of question —E Level 2: Conceptual
4, Correct attempt % Level 3: Applied

PRELIMS COMPLETE REVISION TESTS
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TEST SCHEDULE

“SCHEDULE YOUR OWN TEST”

7 July
(Tuesday)

9 July
(Thursday)

11 July
(Saturday)

12 July
(Sunday)

14 July
(Tuesday)

16 July
(Thursday)

18 July
(Saturday)

FUNDAMENTAL TESTS

Fundamentals of
Polity -1

Fundamentals of
Polity -2

Fundamentals of
History -1

Fundamentals of

History -2

Fundamentals of
History -3

Fundamentals of
Geography -1

Fundamentals of
Geography -2

Topic Covered

Constitutional Development +
Preamble + Union Territories +
Citizenship + FR + DPSP + FD + Other
Constitutional Provisions such as
Emergency Provisions etc.

Executive + Legislature + Judiciary

Ancient + Medieval India History

Modern India (1757 — 1947) History

Art & Culture of India (Visual Arts
+ Performing Arts + Religions +
Languages + Literature + Institutions)

World Geography (Geomorphology
+ Climatology + Oceanography +
Biogeography)

Indian Geography (Indian Physiography
+ Drainage System + Indian Climate +
Soils in India + Natural Vegetation)

PRELIMS COMPLETE REVISION TESTS
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Human & Economic Geography
(Demography + Census + Economic
Activities + Agriculture + Minerals +
Energy Industry + Transport + Trade +
Communication)

19 July Fundamentals of
(Sunday) Geography -3

21 July Fundamentals of

(Tuesday) BT Environment and Ecology + Biodiversity
u y -

Environmental Pollution and
23 July Fundamentals of Management + Climate Change +
(Thursday) Environment -2  Global Warming+ Environmental
Governance

Basic Concepts of National Income +
Budgeting + Fiscal and Monetary Policy
Agricultural and Industrial Policy

25 July Fundamentals of
(Saturday) Economy -1

External Sector + International
26 Jul
y Fuggzroemnta-lz of Institutes + Money, Banking Financial
(Sunday) y Market and Other Provisions

28 Jul
. Funda!mentals i Biology + Everyday Science
(Tuesday) Science -1

Science and Technology (IT + Telecom
30 July Fundamentals of + IPR + Nanotech + Robotics + Nuclear
(Thursday) Science - 2 tech + Biotechnology + Health +
Defence + Space )

REVISION TESTS

Date & Day m Topic Covered

1 August Polity Revision

(Saturday) Test- 1 Complete Polity + Current Affairs
urday -

2 August Polity Revision

(Sunday) Test- 2 Complete Polity + Current Affairs
unday .

PRELIMS COMPLETE REVISION TESTS
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4 August History Revision Complete History + Art and Culture of
(Tuesday) Test India

6 August Geography

e (Thursday) Revision Test

Complete Geography + Current Affairs

8 August Environment Complete Environment + Current
(Saturday) Revision Test  Affairs

9 August Economy

(Sunday) Revision Test  ComPplete Economy + Current Affairs

11 August Science & Complete Science & Technology +

Technology :
(Tuesday) Revision Test Current Affairs

MOCKTEST

Date & Day m Topic Covered

16 August

22
(Sunday)

Mock - 1 PAPER 1 (GS)

18 August

PAPER 2 (CSAT
(Tuesday) ( )

20 August

PAPER 1 (GS
(Thursday) (6S)

22 August

PAPER 1 (GS
(Saturday) (GS)

23 August

PAPER 2 (CSAT
(Sunday) ( )

25 August
27 PAPER 1 (GS)
(Tuesday)

PRELIMS COMPLETE REVISION TESTS
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27 August
(Thursday)

29 August
(Saturday)

30 August
(Sunday)

1 September
(Tuesday)

3 September
(Thursday)

5 September
(Saturday)

6 September
(Sunday)

8 September
(Tuesday)

10 September
(Thursday)

12 September
(Saturday)

13 September
(Sunday)

15 September
(Tuesday)

Mock - 10

Mock - 12

CURRENT
AFFAIRS

Mock - 13

Mock - 14

Mock - 15

CURRENT
AFFAIRS

CURRENT
AFFAIRS

PAPER 1 (GS)

PAPER 2 (CSAT)

PAPER 1 (GS)

PAPER 1 (GS)

PAPER 2 (CSAT)

PAPER 1 (GS)

Economic Survey + Budget + IYB

PAPER 1 (GS)

PAPER 1 (GS)

PAPER 2 (CSAT)

May + June, 2020

July + August, 2020

PRELIMS COMPLETE REVISION TESTS
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LIST OF SOURCES

o Indian Polity for Civil Services Examinations — M.
Laxmikanth. (Polity)

Introduction to the Constitution of India — D. D. Basu
(Constitution)

GSSCORE Target PT Material

Indian Polity &
Constitution

India’s Ancient Past - R.S. Sharma. (Ancient India -
Text Book)

History Of Medieval India - Satish Chandra.
(Medieval India - Text Book)

History Of Modern India - Bipan Chandra. (Modern
India - Text Book)

Indian History and India’s Struggle For Independence - Bipan Chandra.
Culture (Modern India - Read like a story)

Indian Art and Culture - Nitin Singhania. (Culture)

Ancient and Medieval India - Poonam Dalal (Ancient
and Medieval India)

A Brief History of Modern India - Spectrum (Modern
India)

GSSCORE Target PT Material

NCERT (Class 7% to 12t

Certificate Physical and human Geography by Goen
Che Leong

GSSCORE Target PT Material

Geography

PRELIMS COMPLETE REVISION TESTS
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Class 12" Biology

Environment & Ecology: A Complete Guide by R.
Environment Rajgopalan
IGNOU Environment & Ecology

GSSCORE Target PT Material

NCERT (10™, 11t And 12t)
Economic Survey of Last 3 years
Indian Economy - Ramesh Singh
GSSCORE Target PT Material

Economics

NCERT (6" to 10t)

Science & Technology | oo 0RE Target PT Material

Current Affairs o GSSCORE Target PT Material

PRELIMS COMPLETE REVISION TESTS
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3000+ TOPICS COVERED

» 3000* Topics to be covered, through Smart Solution. It can be used as
REVISION NOTES

» SMART Solutions will be provided so that you learn how to approach a
question in the exam, even if you don't have the full knowledge of the topic
given.

EXAMPLE:
Let's see how smart solution can be effective through a practice question.

Q. Which of the following are the characteristics of a stable ecosystem?
1. Dynamic Equilibrium
2. Maturity
3. Highinertia
4. Low Species Diversity
Select the correct answer using the code given below:
(@) 1,2 and 3 only
(b) 1,2 and 4 only
(c) 3 and 4 only
(d) 1,2,3and 4

A. Correct Option: (a)
Explanation:

o Statement 4 is incorrect: These ecosystems have high (not low) species
diversity.

Supplementary notes :
Ecosystem Stability

» Ecosystem stability refers to the capability of a natural ecosystem to apply self-
regulating mechanism so as to return to a steady state after an outside disturbance.
Ecosystem stability means there is a balance between production and consumption of
each element in the ecosystem.

PRELIMS COMPLETE REVISION TESTS
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» The Principles of Ecosystem Stability are:

o Ecosystems dispose of waste and replenish nutrients by recycling all
elements.

Ecosystems use sunlight as their source of energy.

The size of a consumer population is maintained such that overgrazing and
other forms of overuse do not occur.

o Biodiversity is maintained.
Some of the important characteristics of a stable ecosystem are:

They are in dynamic equilibrium. It means there is a relatives stability within a
community of organism in terms of genetic, species and ecosystem.

They are mature ecosystems. For example mixed tree size forest ecosystem
characterised by a complex food web system in which a number of species are
interdependent and interconnected .

These ecosystems have high inertia. An inertia of an ecosystem refers to the delay or
slowness in the response of an ecosystem to certain factors of change.

» These ecosystems have high (not low) species diversity.

Smart Solution

If a candidate knows that these ecosystems have high (not low) species diversity
CODE (b), (c) and (d) can be straightaway rejected.

*kkkkkkkkk
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TEST: 1

FUNDAMENTAL OF POLITY - 1

(CONSTITUTIONAL DEVELOPMENT + PREAMBLE +
UNION TERRITORIES + CITIZENSHIP + FR + DPSP + FD
+ OTHER CONSTITUTIONAL PROVISIONS SUCH AS
EMERGENCY PROVISIONS ETC.)

Historical Evolution &
Features
» What is Constitution?

» Importance of Constitution
» Historical evolution of the

vV V. v VvV VvV VvV VvV VY

Constitution

Constituent Assembly

Objectives of the Constitution

Salient features of Indian Constitution
Unitary features

Federal features

Parliamentary form of government
Presidential form of government

Parliamentary vs. Presidential system
of government

Preamble

Preamble
Basic features
Value premises of constitution
Terminologies as:
Democratic
Sovereign
Socialist
Secular
Republic
Justice

Equality
Liberty
Fraternity
Integrity

Fundamental Rights

>

Meaning and importance of
Fundamental Rights

Right to Equality

Right to Freedom

Right against Exploitation

Right to Freedom of Religion
Cultural and Educational Rights
Right to Constitutional Remedies

Difference between procedure
established by law and due process
of law

» Writs and their uses
» Restrictive limitations on fundamental

rights

DPSP

>
>
>
>
>
>

PRELIMS COMPLETE REVISION TESTS

Basic features

Economic and Social DPSP
Gandhian DPSP

Administrative DPSP

DPSP related to international peace
Implementation of DPSP
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5.

Fundamental Duties

» Features

» Link of Fundamental Rights and
Fundamental Duties

Citizenship

» Basic constitutional features
Methodology of getting citizenship

» Modes of Losing the Citizenship of
India

» Concept of dual citizenship

» Citizenship provisions in J&K
Special privileges enjoyed by citizens
in India

Panchayats

Brief history

Provisions of 73 AA

Role and functions of different tiers
Provisions of 74" AA

Role and functions of different tiers
Municipal Corporations

Municipal Councils

Nagar Panchayats

The steps taken towards women's
empowerment

» Role of State Election Commission
» Role of State Finance Commission
» XI™ and XII" Schedules

YV VvV VvV VY VvV VYV VvV VY

The Scheduled and Tribal
Areas

» 5" schedule areas
» 6" schedule areas

PRELIMS COMPLETE REVISION TESTS

» Composition of autonomous councils
» Role and functions of councils

» Role of Governor with respect to tribal
areas

» Tribal sub plan

Relations between the Union
& the States

Administrative relations
Legislative relations
Financial relations

Misuse of emergency powers
Issue of devolution of funds
Interstate council

Zonal council

vV VvV v VvV Vv Vv Vv Y

Cooperative federalism concept

. Services

» All India Services
» State Services

» Central Services
) 4

Union Public Service Commission
(UPSC)

» State Public Service Commission
(SPSC)

» Joint Public Service Commission
(JPSC)

. Tribunals

Need of tribunals
Salient features of tribunals

Procedure

>
>»
» Composition
>
>

Powers and functions
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» Different types of tribunals: some
examples

12. Elections

» Importance of Universal Adult
Franchise

Constitutional provisions
National and state party
Types of elections

Electoral reforms

State funding

Changes in Corporate Funding
NOTA in Elections

E- Postal Ballot

. Special Provisions Relating
To Certain Classes

» Reservation of seats for Scheduled
Castes and Scheduled Tribes in
centre and state legislatures

Representation of the Anglo-Indian
Community

National Commission for Scheduled
Castes and Scheduled Tribes

. Official language provisions

» Official language of the Union
» Commission and Committee of

>
>
>
>
>

*kkkkkkkkk
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Parliament on official language
Official language or languages of a
State

Official language for communication

between one State and another or
between a State and the Union

Language of The Supereme Court, High
Courts, etc.

Special Officer for linguistic
minorities

. Emergency provisions

National emergency
State emergency
Financial emergency

Procedure of proclamation and
removal of emergency

Emergency and fundamental rights
Impact of emergencies

. Amendments

Procedure of amendment

Special majorities

Important amendments

Special provisions to different states
Provisions related to NE states
Provisions related to J&K
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FUNDAMENTAL OF POLITY - 2
(EXECUTIVE + LEGISLATURE + JUDICIARY)

Union and States

» State Reorganization Commission
(brief)

» Components of Indian territory

» Process of formation of new states

» Union territories

» Special provisions for states

The President

Importance of President
Qualification
Election procedure

Advantages and disadvantages of
single transferable form of voting

Presidents’ Term of Office and
emoluments

Executive Powers
Legislative Powers
Emergency Powers
Financial Powers
Miscellaneous powers
Judicial powers
Presidents Impeachment
President as nominal head

vV V VvV VYV VY VvV VY

Vice President

» Office of the Vice-President
» Functions

Prime Minister
» Appointment of PM

PRELIMS COMPLETE REVISION TESTS

» Functions of PM

» Role of PM with respect to
o CoM

o President

o Lok Sabha

o Political Party

o Coalition Government

Council of Ministers

Division of CoM

Role of CoM

Role of Cabinet

Responsibilities of the Ministers

>
>
>
>

Attorney General of India

» Qualification
» Functions
» Powers with respect to parliament

Parliament

Functions of Parliament
Composition of Rajya Sabha
Composition of Lok Sabha

Qualification and disqualification of
MPs

Vacation of seats

Sessions of parliament

Law making procedure

Officers of Parliament

Parliament Proceedings

Motions and resolutions in Parliament
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12. Chief Minister

» Powers and Privileges
» Budget making process

» Comparison of Lok Sabha and Rajya
Sabha

Types of majorities
» Special powers of RS

The Union Judiciary

» Integrated judicial system
» Supreme Court
Composition
o Independence of Supreme Court
o Jurisdiction of SC
o Judicial Review

High Court

» Composition
Terms and removal
Jurisdiction

Other powers
Lower judiciary

o Appointment

o Powers

>
>
>
>

. Comptroller and Auditor-
General of India

» Appointment
» Functions
» Role of CAG in good governance

. The Governor

» Appointment, term of office,
qualification, etc

» Powers
» Discretionary powers
» Ordinance making power

Appointment
Powers and responsibilities

Relationship between the Governor
and the Chief Minister

Relationship between CoM and the
Chief Minister

. Council of Minister (CoM)

>
>
>
>

Division of CoM

Role of CoM

Role of Cabinet

Responsibilities of the Ministers

. The Advocate-General for
the State

>
>

Appointment
Functions

. State legislature

>

The composition of Vidhan Sabha and
Vidhan Parishad

Qualifications of the Members of
Legislature

Powers and Functions of State
Legislature

» Relationship between both the Houses
» Officers of State Legislature
» Powers, Privileges and Immunities of

State Legislatures and their Members

» Legislative procedure
» Governor’s assent to Bills
» Procedure in Financial Matters/Budget

16. Miscellaneous

»

PRELIMS COMPLETE REVISION TESTS

President Election Procedure (Right to




18 |AS 2020

vote or not to vote)
Concept of Office of Profit

» Types of CAG audit
» Reforms in Parliament functioning to

vV VYV VYV YV VY VvV VY VY

increasing efficiency

Dilemma of delimitation

Significance of WHIP

Declaration of assets of MP’s

NOTA in Rajya Sabha polls

Demand for a hybrid electoral system
Various types of electoral systems
First past the post system
Proportional representation

Mixed systems also sometimes
referred to as Hybrid system

Motion of Thanks

» Privileges to MP

Y VY VYV VY VY VY VY

*kkkkkkkkk
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Ordinance making powers
Parliamentary committees
National Court of Appeal

Middle Income Group Legal Aid
Scheme

Public Interest Litigation
Criminal Defamation
Capital Punishment
E-Courts

Tele-law initiative
Pro-bono legal services
Prison reforms

Law panel on Tribunals

S.C Collegium proceedings in public
domain

Law Commission Report on United
Nations Convention against Torture
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FUNDAMENTAL OF HISTORY - 1
(ANCIENT + MEDIEVAL INDIA)

» Paintings
ANCIENT INDIA » Decline of Harappan Culture

1. Pre Historic Cultures In India 4. Vedic Society

Periodization of Indian Pre History Original Home of Aryans

Sources of Pre History

Food Gathering Communities
Food Producing Men

Neolithic or the New Stone Age
Iron Age

Impact of Iron

Pastoral and Farming
Communities

» Neolithic Phase
» Chalcolithic Phase
» Early Iron Phase

» Geographical Distribution and
Characteristics

Indus Valley Civilization

Major cities

Town Planning

Harappan Trade
Agriculture
Domestication of animals
Crafts

Religion

Harappan Pottery
Weights and Measures
cript and Language

YV vV VY VvV VvV VY VY VvV VY

PRELIMS COMPLETE REVISION TESTS

Features of Aryan Culture
Vedic Texts

Sources for Reconstructing Vedic
Society and Culture

Geography of the Rig Vedic Period and
geography of the later Vedic Phases

» Economic Conditions

» Political Organisation and Evolution of
Monarchy

» Social Organisation and Varna System
» Religion and Thought

Pre Mauryan Period

Formation of states

The Sixteen Mahajanapadas
Republics

Rise of urban centres
Haryanka dynasty
Shishunaga dynasty

Nanda dynasty

The Mauryan Empire

» Chandragupta and Bindusara
» Megasthenes

» Asoka and His Successors

» Asoka’s Inscriptions and Sites




» Asoka a Dhamma

» Mauryan Administration, Economy,
Society and Art

» The Arthasastra

Post-Mauryan India
(SC 200-AD 300)

» Society: Evolution of Jatis
» Sangam Texts-and Society
)

Satavahanas and Other Indigenous
Dynasties

» Foreign Dynasties

» Commercial Contacts with the Outside
World

» Schools of Art

Growth of Jainism and
Buddhism

» Jainism
» Buddhism

Imperial Guptas

Sources of Gupta Rule
Political history of Guptas
Fahien

Gupta Administration

Gupta Culture

Urban centres in Gupta period
Economic Conditions

. Harshavardana

» Sources for Harsha's Period
» Early life of Harsha

» Harsha's Administration

» Important Officials of the empire
» Economy under Harsha

20 |AS 2020
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» Society
» Religion

11. The Southern Dynasties

The Satavahanas (230 BC TO AD 225)
The Pallavas (AD 330-796)
The Chalukyas (AD 535-1190)

The Pandyas of Madurai (AD 590-
1323)

» The Chola Dynasty (AD 850-1310)
» Rashtrakutas (AD 753-973)

MEDIEVAL INDIA

1.

PRELIMS COMPLETE REVISION TESTS

Central Asian Politics
and the Advance of Babur
towards India

» The Timurids

» The Timurid-Uzbek and Uzbek-Iran
Conflict and Babur

» Babur's Advance towards India.

Struggle for Empire in North
India (Afghans, Rajputs and
Mughals

» Struggle between Ibrahim Lodi and
Babur

» The Battle of Panipat

» Babur's problems after the Battle of
Panipat

» Struggle with Rana Sanga

» Problems of the Eastern Areas and the
Afghans

Babur’s Contribution and Significance
of his Advent into India
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3.

Struggle for Empire in North
India

» Humayun and the Afghans

» Early Activities of Humayun, and the
Tussle with Bahadur Shah

» The Gujarat Campaign

» The Bengal Campaign, and Struggle
with Sher Khan

The Establishment of the
North Indian Empire

The Surs
Sher Shah's Early Life

Social and Political Background of
Bihar and the Rise of Sher Shah to
Power.

The Sur Empire (1540-56)
Contributions of Sher Shah

Consolidation and Expansion
of the Empire - Akbar

Conflict with the Afghans - Hemu
Struggle with the Nobility: Bairam
Khan's

Regency; Revolt of Uzbek Nobles
Early Expansion of the Empire (1560-
76) - Malwa, Garh-Katanga, Rajasthan,
Gujarat, Eastern India

Relations with the Rajputs - Growth of
a Composite Ruling Class

Rebellions, and Further Expansion of
the Empire in the North West

PRELIMS COMPLETE REVISION TESTS

State and Government under
Akbar

» Akbar's Concept of Suzerainty

» Structure of Government, Central and
Provincial -the Vikalat, the Central
Ministries, Provincial

Government, District and Local
Government

The Working of Government - the
Ruler, Land-Revenue System, the
Dahsala System, the Mansabdari

» System and the Army

Akbar’s Religious Views

» Relations with the Ulama and Social
Reforms

» The Early Phase (1556-73)

» The Second Phase (1573-80) - the
Ibadat Khana

Debates - the Mahzar - Breach with
Orthodox

Ulama - Re-organisation of Madadd-i-
Maash Grants

» Third or Final Phase - Din-i-llahi - State
» Policies and religious toleration

The Deccan and the Mughals
(Upto 1657)

» The Deccani States upto 1595
» Mughal Advance towards the Deccan
>

Mughal Conquest of Berar, Khandesh
and Parts of Ahmadnagar

Rise of Malik Ambar, and Frustration
of Mughal Attempt at Consolidation
(1601-27)

Extinction of Ahmadnagar,
Acceptance of Mughal




» Suzerainty by Bijapur and Golconda
» Shah Jahan and the Deccan (1636-57)

» Cultural Contribution of the Deccani
States

Foreign Policy of the
Mughals

» Akbar and the Uzbeks

» The Question of Qandahar and
Relations with Iran

» Shah Jahan's Balkh Campaign

» Mughal - Persian Relations - the Last
Phase

. India in the First Half of the
Seventeenth Century

» Jahangir's Accession - his Early
Difficulties

Territorial Consolidation and
Expansion of the Empire - Mewar, East
India and Kangra

» Jahangir as a Ruler
» NurJahan, and the NurJahan ‘Junta’

» The Rebellions of Shah Jahan, and
the coup de main of Mahabat Khan

State and Religion in the First Half of
the Seventeenth Century

Shah Jahan - Consolidation and
Expansion of the Empire

Evolution of the Mughal Ruling Class
and the Mansabdari System

. Aurangzeb - Religious
Policies, North India and the
Rajputs

» War of Succession

PRELIMS COMPLETE REVISION TESTS

22 |AS 2020 GSSCORE

Religious Policy : First Phase
(1658-79)

Reforms and Puritanical Measures,
Hindu

Temples, Jizyah; Second Phase
(1679-1707)

Territorial Consolidation and
Expansion of Empire - North India

Popular Revolts - Jats, Satnamis,
Afghans and Sikhs

» Breach with Marwar and Mewar

. Climax and Crisis of the

Mughal Empire the Marathas
and the Deccan

» Rise of the Marathas - Early Career of
Shivaji -
» Treaty of Purandar - the Agra Visit

» Shivaji's Swarajya - Administration
and Achievements

Aurangzeb and the Deccani States
(1658-87)

» Marathas and the Decean (1687-1707)

» Assessment of Aurangzeb and the
Jagirdari Crisis

. Society-Structure and

Growth

Rural Society

Towns and Town Life

Artisans and Master-Craftsmen
Women

Servants and Slaves

Standard of Living

The Ruling Classes - Nobility, Rural
Gentry
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» The Middle Strata
» The Commercial Classes

. Economic Life-Patterns and
Prospects

» Inland Trade

» Overseas Trade - Role of Foreign
Trading

Companies - Position of Indian
Merchants Over-land Trade

The Mughal State and Commerce

» Trend of India’s Economy and
Prospects during the First Half of the
Eighteenth Century

. Religion, Fine Arts, Science

and Technology
» Religion- Hindu Religion, Sikh
Religion, Islam

» Fine Arts - Architecture, Painting,
Language and Literature, Music

» Science and Technology

. Northern India in the First
Half of the Eighteenth
Century

» Bahadur Shah I, and the Beginning of
the Struggle

For Wizarat - Rajput Affairs - Marathas
and the

Deccan - Accentuation of the Party
Struggle

Struggle for ‘New' Wizarat: Zulfigar
Khan and Jahandar Shah (1712-13)
The Saiyid Brothers’ Struggle for
‘New' Wizarat

The Saiyid ‘New’ Wizarat

The Wizarat of M. Amin Khan and
Nizam-ul-Mulk

Rise of Regional States, Beginning of
Foreign Invasions of India (1725-48)

. The Maratha Bid for
Supremacy

» The Marathas and their Policy of
Expansion

The Marathas and Nizam-ul-Mulk

The Maratha Advance into Gujarat
and Malwa

The Maratha Advance into Doab and
Punjab:
First Phase (1741-52); Second Phase
(1752-61);

» Third Battle of Panipat

*kkkkkkkkk

PRELIMS COMPLETE REVISION TESTS
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FUNDAMENTAL OF HISTORY- 2
(MODERN INDIA (1757 - 1947)

MODERN INDIA

1.

The Advent of Europeans In
India

» The Portuguese in India

o De Almeida

o Albuquerque

o Causes of failure of Portuguese
empire in India

The Dutch in India

The Danes in India

The English

The French

Anglo-French Rivalry
First Carnatic War
Rise of the Hyderahad State
The Second Carnatic War
The Third Carnatic War
Causes of English Success

The English in Bengal from
1757 10 1772

» Black-hole Tragedy

» Battle of Plassey

» Mir Jafar

» Deposition of Mir Jafar
» Mir Kasim

Impact of British

Administration

>

Industrialization—Ruin of Artisans and
Handicrafts men

» Impoverishment of Peasantry
» Emergence of New Land Relations,

Ruin of Old Zamindars

Stagnation and Deterioration of
Agriculture

Commercialization of Indian
Agriculture

Development of Modern Industry
Rise of Indian Bourgeoisie
Economic Drain

Famine and Poverty

Nationalist Critique of Colonial
Economy

Abolition of the Dual System
Zamindari system

Ryotwari system

Mahalwari system

The Revolt of 1857

YV VYV VYV VYV vV VYV Vv VY

PRELIMS COMPLETE REVISION TESTS

Economic Causes

Political Causes
Administrative Causes
Socio -Religious Causes
Influence of Outside Events
Discontent Among Sepoy’s
Beginning and Spread
Leaders of the Revolt
Suppression of Revolt
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Causes of Failure of Revolt
Hindu-Muslim Unity Factor
Nature of the Revolt
Consequences

Administrative Changes
After 1857

» Administration - Central, Provincial,
Local

Changes in the Army
Public Services
Princely States
Administrative Policies
Foreign Policy

Social reforms in India

Raja Ram Mohan Roy

Swami Vivekananda

Swami Dayananda Saraswati
Ishwar Chandra Vidyasagar
Jyotiba Phule

Dr. Bhimrao Ramji Ambedkar
Henry Vivian Derozio
Debendranath Tagore
Keshab Chandra Sen

Sri Ramakrishna Paramhamsa
Mahadev Govind Ranade

Theosophical Society And Annie
Besant

Syed Ahmad Khan

vV VvV Y Vv VY Y VYV VYV Vv VvV Vv Y

Development of Indian Press

» Early Regulations on Press
» Struggle by Early Nationalists to

Secure Press Freedom

Vernacular Press Act, 1878

During and After the First World War
During the Second World War

After Independence

Development of Education

Charter Act of 1813
Orientalist-Anglicism Controversy
Efforts of Thomson

Wood's Des-patch (1854)

Hunter Education Commission (1882-
83)

» Indian Universities Act, 1904
» Government Resolution on Education

Policy—1913

Saddler University Commission (1917-
19)

» Education Under Dyarchy
» Hartog Committee (1929)

Wardha Scheme of Basic Education
(1937)

Sergeant Plan of Education

» Kothari Education Commission (1964-

66)

» Development of Vernacular Education
» Development of Technical Education
» Evaluation of British Policy on

Education

Struggle by the Masses

Baba Dayal Das » Tribal Movements
PanditaRamabai o Bhil Uprising

Sarojini Naidu o Kol Uprising

Parsi Religious Reform Association

PRELIMS COMPLETE REVISION TESTS




o Santhal Rebellion

o Jaintia and Garo Rebellion
o Rampa Rebellion

o Munda Rebellion

o Khonda Dora Uprisings
o Tana Bhagat Movement
Peasant Movements
Champaran Satyagraha
Kheda Peasant Struggle
Bardoli Movement
Moplah Rebellion
Tebhaga Movement
Telangana Movement

(0]
(0]
(0]
(0]
(0]
(0]

. Terrorist and Revolutionary
Movements
» Terrorist Movements

» The Revolutionary Movement
» Reasons for Failure

. The Early Phase of
the Freedom Struggle
(1900-1915)

» Partition of Bengal (1905)

» Swadeshi Movement (1905)

» Origin of the Muslim League (1906)
» Resolution of Swaraj (1906)
>

Surat Session: Split in Congress
(1907)

» Morley-Minto Reforms (1909)

. Middle Phase of the
Freedom Struggle
(1915-1930)

» World War I-Reforms and Agitation

GSSCORE

Home Rule Movement (1915-1916)
Lucknow Pact (1916)

August Declaration of of 1971
Beginning of the Gandhian Era

The Government of India Act (1919)
Rowlatt Act (1919)

Jallianwala Bagh Massacre (13 April
1919)

» Khilafat Movement (1920)
» Non-Cooperation Movement (1920-

vV V VYV VYV YV VYV VY VY VYV VY VY VY

(

1922)

Chauri-Chaura Incident (1922)
Trade Union Movement
Communist Movement in India
Swaraj Party (1922)

Muddiman Committee (1924)
Simon Commission (1927)
Butler Committee (1927)

Delhi Muslim Proposal (1927)
Nehru Report (1928)

All Parties Muslim Conference (1929)
Jinnah's Fourteen Points (1929)
Lahore Session (1929)
Allahabad Address (1930)

. Closer to Freedom
1930-1947)

Civil Disobedience Movement (1930)

The First Round Table Conference
(1930)

» Gandhi-lIrwin Pact
» Second Round-Table Conference

(1931)

Civil Disobedience Movement (Second-
Phase)

» Third Round Table Conference (1932)
» The Communal Award (1932)

PRELIMS COMPLETE REVISION TESTS
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» Poona Pact (1932)
» The Government of India Act (1935)

» World War Il and the Indian Political
Situation

Resignation of Congress Ministers
(1939)

Poona Resolution and Conditional
Support to Britain (1941)

August Offer of 1940

The Individual Civil Disobedience
Two-Nation Theory

Demand for Pakistan (1942)
Cripps Mission (March 1942)

Quit India Movement (1942-1945)
The CR Formula (1944)
Gandhi-Jinnah Talks (1944)
Desai-Liagat Pact (1945)

Wavell Plan and Simla Conference
(1945)

Provincial and General Elections of
1945

» Cabinet Mission Plan (1946)

» Azad Hind Fauj (Indian National
Army)

Direct Action Campaign (1946)
Interim-Government (1946)
Mountbatten Plan (1947)

India Wins Freedom

Indian Independence Act (1947)
Partition of India

g
>
>
>
>
>
>
>
>

. Governor Generals During
British India

» Robert Clive (1754-1767)

» Lord Warren Hastings (1773-1785)
» Lord Cornwallis (1786-1793)

» Sir John Shore (1793-1798)

vV Vv v Y Y Y Y VY VY Y Y VY VY VY VY Vv Vv Vv Y
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Lord Arthur Wellesley (1798-1805)
Lord George Barlow (1805-1807)
Lord Minto-1 (1807-1813)

Francis Rawdon Hastings (1813-
1823): (Marques of Hastings)

Lord Amherst (1823-28)

Lord William Bentinck (1828-1835)
Sir Charles Metcalfe (1835-1836)
Lord Auckland (1836-1842)

Lord Ellenborough (1842-1844)
Lord Hardinge- (1844-1848)

Lord Dalhousie (1848-1856 great
imperialist and colonist)

Lord Canning (1856-1857 and 1858-
1862)

Lord Elgin-I (1862-1863)

Lord Lawrence (1862-1869)
Lord Mayo (1869-1872)

Lord North Brook (1872-1876)
Lord Lytton (1876-1880)

Lord Rippon (1880-1884)

Lord Dufferin (1884-1888)
Lord Lansdowne (1888-1894)
Lord Elgin-Il (1894-1999)

Lord Curzon (1899-1905)

Lord Minto-I (1905-1910)
Lord Hardinge-11 (1910-1916)
Lord Chelmsford (1916-1921)
Lord Reading (1921-1926)
Lord Irwin (1926-1931)

Lord Willingdon (1931-1936)
Lord Linlithgow (1936-1944)
Lord Wavell (1944-1947)

Lord Mountbatten (1947-1948)




all e 20

FUNDAMENTAL OF HISTORY- 3

. ART & CULTURE OF INDIA
TEST' 5 (VISUAL ART + PERFORMING ARTS + RELIGIONS +
LANGUAGES + LITERATURE + INSTITUTIONS)

VISUAL ARTS

Sculptures

» Sculptures of Harappan Civilisation

Pandya Temples
Vijaynagar Period
NayakaTemples
Temples of Kerala
Vesara Style
Hoysala Style
Sculptures of Mauryan Age Rashtrakuta Period
Post-Mauryan Period Schools of Temple Architecture
Jain Sculptures Nagara Style
Buddhist Sculpture Hoysaka Style
Gupta Sculpture Dravidians Style
Medieval School of Sculpture Vesara Style
Modern Indian Sculpture

vV V. v VvV VvV VvV Vv Y

3. Indo-Islamic Architecture
Architecture in Ancient India e .
mperial Style (Delhi Sultanat

Harappan Period Provincial Style
Mauryan Architecture Mughal Style
Post-Mauryan Period Sikh Style of Architecture

Gupta Period Rajput Architecture
Temples of Khajuraho Salient features

Temples of Odisha

Temples of Gwalior . Modern Architecture
Temples of Gujarat

Temples of Rajasthan

Temples of Bengal

Temples of Assam

Temples of Himachal Pradesh
Temples of Jammu and Kashmir
Pallava Period » Cave Paintings

Chola Period » Tradition of Mural Paintings in India

» European Influence
» Indo-Saracenic Architecture
» Post-Independence Period

Indian Paintings

YV V Y VYV vV VY VY Y Y VY VY VY VY VY

PRELIMS COMPLETE REVISION TESTS
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Tradition of Miniature Paintings in

India

Paintings in the Deccan

Rajput School of Painting

Pahari School of Painting
Miniature Painting in South India
Regional Paintings

Modern Paintings
Contemporary Paintings

6. Pottery Tradition in India

» Ochre: Coloured Pottery (OCP)
» Black and Red Ware (BRW)
» Painted Grey Ware (PGW)

» Northern Black Polished Ware
(NBPW)

» Glazed and Unglazed Pottery

PERFORMING ARTS

1. Music in India

» Classical Indian Music
e Hindustani Music
o Carnatic Music
Main Pillars of Indian Music
Forms of Indian Music
Musical Instruments
Institutions Related to Music
Folk Music in India

2. Dances in India

» Concept of Dance in India
» Concept of Ashta Nayika

» Eight Classical Dance Forms in India

» Folk Dances
» Modern Dances

PRELIMS COMPLETE REVISION TESTS

Sports in India

» Various Type of Sports
» Genesis of Martial Arts

» Forms of Traditional Martial Arts
» Animal Sports

Indian Theatre

History of theater in India
Classical Sanskrit Theatre
Traditional Theatre

Regional Theatre

Modern Theatre

Renaissance of Indian Theatre
Cinemain India

o History of Indian Cinema

o Classification of Indian Cinema
Film

Indian Puppetry

» String Puppets
» Shadow Puppets
» Rod Puppets

» Glove puppets
» Modern Puppetry
» Tribal Puppetry

RELIGION, LANGUAGE
AND LITERATURE IN

INDIA

Religions in-India

» Pre-Vedic Religion
» Hinduism

» Buddhism

» Jainism

» Sikhism




» Islam

» Christianity

» Zoroastrianism

» Judaism

» Philosophy in India

Bhakti and Sufi Movements

» Bhakti Movement
» Saints of Bhakti Movement
» Sufism

Languages and Literature in
India

Sanskrit Literature
Pali Literature
Prakrit Literature
Tamil Literature
Telugu Literature
Malayalam Literature
Kannada Literature
Odia Literature
Assamese Literature

>
>
>
>
>
>
>
>
>
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___An Institute for Civil Services

Bengali Literature
Gujarati Literature
Rajasthani Literature
Punjabi Literature
Marathi Literatur
Hindi Literature
Persian Literature
Urdu Literature

Contribution of Language and
Literature of foreign languages

MISCELLANEOUS

>
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PRELIMS COMPLETE REVISION TESTS

UNESCOQ's List of Cultural Heritage in
India

Protection and Promotion of
Indian Culture and Heritage: Legal
Provisions

Schemes and Awards
Personalities Related to Culture
Places of Cultural Interest

The Calendar & the Eras

Science and Technology in Ancient
India
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FUNDAMENTAL OF GEOGRAPHY- 1

(GEOMORPHOLOGY + CLIMATOLOGY +
OCEANOGRAPHY + BIOGEOGRAPHY)

GEOMORPHOLOGY 5. Geological Time Scale

1. The origin of the Earth

» Early Theories

» Modern Theories

» Star Formation

» Formation of Planets
» Solar System

2. The Evolution of the Earth

» Layered Structure

» Evolution of Lithosphere

» Evolution of Atmosphere
» Evolution of Hydrosphere

3. Geological History of the
Earth

4. Earth

» Latitude and Longitude including
important Parallels and Meridians

Motions of the Earth - Rotation,
Revolution and their effects

Inclination of the Earth's Axis and its
effects

Local and Standard Time and the
International Date Line, Calendar

» Eclipses - Solar, Lunar
» Earths Magnetic Field

PRELIMS COMPLETE REVISION TESTS

» Origin of Life

Interior of the Earth

» Sources of Information
o Direct

o Indirect - Earthquake Waves,
Volcanoes

» Crust
» Mantle
» Core

Geology

» Minerals
» Major Elements of the Earth’s Crust

o Minerals - Feldspar, Quartz,
Pyroxene Amphibole , Mica, Olivine

Physical Characteristics - Crystal
Form, Cleavage Fracture, Lusture,
Color, Streak

o Transparency, Structure, Hardness,
Specific Gravity

Metallic minerals - precious
Ferrous , Non Ferrous

Non-metallic Minerals - Sulphur,
Phosphates, Cement

» Rocks (Aggregate of Minerals)
o Petrology
o Rocks & landforms
o Rocks & Soils

» 3 Family of Rocks




2 GOl

o Igneous Diastrophism

o Sedimentary o Orogenic

o Metamorphic o Epierogenic
» Rock Cycle o Earthquakes

o Plate movements
Earthquakes > Volcanism

Waves: PS, Body, Surface o Exogenic Forces
Shadow Zone o Denudation Processes

>
»
» Types of Earthquakes » Weathering

» Effects » Mass movements
»

»

Frequency o . .
Locating an Epicentre . Distribution of Continents &
Oceans

Volcanes » Theories

» Types » Continental Drift Theory
o Shield o Alfred Wegner 1912
o Composite e Pangea, Panthalasa
o Caldera o Laurasia, Gondwanaland
(0]
(o}

Flood Basalt Evidence in support of Continental
Mid Ocean Ridge Drift Theory

Landforms (intrusive) o Jigsaw Fit
Batholiths Rocks of Same age across oceans
Lacoliths Tillite
Lapoliths Placer Deposits
Phacoliths Distribution of Fossils
Sills » Isostacy - Sea Floor Speading
Dykes » Forces of Drifting
o Pole Fleeing Force
. Geomorphic Processes o Tidal Force
> Earth's Surface Post Drift Studies
o Exogenic Forces o Convectional Current Theory

o Endogenic Forces o Mapping of the Ocean Floor

o Gradation, Degradation & » Continents - plate Tectonics
Agradation » Lithospheric Plates

» Geomorphic Process o Major Plate
» Endogenic Process o Minor Plates

(0]
(0]
(0]
(0]

PRELIMS COMPLETE REVISION TESTS
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» Plate Boundaries Valleys

o Divergent Rills

o Convergent Gullies

o Transform Valleys - V Shape, Gorge (Hard
» Rates of Plate Movements Rocks), Canyon (Sedimentary)

» Force of plate movements Potholes & Plunge pools
» Indian Plate Incised or entrenched meanders

River Terraces - paired &

Landforms and their unpaired
Evolution Depositional Landforms

e Alluvial Fans

» Causes « Delta
o Geomorphic Processes e Flood Plains, Natural Levees,
o Geomorphic Agents Point Bars
o Erosional or Destructional Meanders, Slip off bank, Under
Depositional or Constructional cut bank
Agents and their Impacts o Oxbow lake
o Wind, Running Water, Ground Water, e Braided Channels

Glaciers, Waves & Currents » Ground Water (Karst Topography)
Winds o Permeable Rocks
o One of the Two dominant agents in e Percolation
Hot deserts o Bedding Plains
Cause - Deflation Abrasion Impact o Limestone and Dolomite Regions
Erosional landforms « Balkans, Adjacent to Adriatic
e Pediments and Pediplains regions
e Playas o Erosional Landforms
o Deflation Hollows and Caves e Pools - Swallow Hole, Valley

o Mushroom, Table & Pedestal Sinks (Uvalas), Sinkholes,
Rocks Collapse sinks (Dolines), Lapies,

. Ridges, Limestone Pavements
Depositional Landforms g

e Caves - Altering bed of Rocks
* Barchans (Shale sandstone quartzit, Caves
o Seif and Tunnels

e Parabolic o Depositional landforms
e Transverse o Stalactites

e Longitudinal o Stalagmites
Running Water e Pillar Columns
o Erosional Landforms » Glaciers

PRELIMS COMPLETE REVISION TESTS
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o Erosional Landforms o Hydration
e Cirque of Tarn Lakes o Oxidation & Reduction

e Hors and Serrated Regions - Physical Forces Gravitational,
Arete Expansion, Water Pressure

e Glacial Valleys / Troughs - e Unloading & Expansion

Fiords o Temperature changes and
o Depositional Landforms Expansion

Glacial Tills o Freezing, Thawing, & Frost
Moraines Wedging
Eskers o Salt Weathering
Outwash Planes Biological Weathering
Drumlins o Burrowing

» Waves and Currents o Wedging

o High Rocky Coasts & Low o Plant Roots
Sedimentary Coasts

o Erosional Landforms

Effects of Weathering
o Exfoliation (Flakin) — Exfoliation

o Cliffs Domes
e Terraces Significance of Weathering

e Caves o Soil Formation

e Stacks o Biomes and Biodiversity
o Depositional Landforms o Leaching / Enrichment
e Beaches and Dunes

o Bars, Barriers, Spits o Activating causes

» Weathering o Forms of movement - Heave, Flow,
o Weather over Earth Materials Slide

e Factors
o Geological 13. Landforms across the world
e Climatic
Topograhic
o Vegetative
» Major Processes

o Chemical
o Physical or Mechanical CLIMATO LO GY

o Biological » Composition
» Chemical - Forces Chemical Action » Gases
»
>

Mass Movements

» Rivers and lakes
» Mountain and Peaks
» Plateaus

o Solution Water Vapour
o Carbonation Dust Particles

PRELIMS COMPLETE REVISION TESTS




Structure

o Exosphere

e Thermosphere
o Mesosphere

o Stratosphere

o Troposphere

» Altitude vs Temperature
» Insolation
» Solar Radiation Heat Balance

Temperature

» Aphelion and Perihelion

Variability of Insolation at the surface
of the Earth

o Day Season Year

o Rotation on Axis, Angle of
Inclination of sun rays, Length of
the day

o Transparency of Atmosphere,

configuration of land in terms of its
aspect.

» Heat Balance

Heating and cooling of atmosphere
e Conduction
o Convection
o Advection

» Terrestrial Radiation
» Heat Budget of the Planet Earth
» Macro Budget

o Albedo
o Shortwave Radiation
o Long wave Earth Radiation

Variation in the net Heat Budget at the
Earth's Surface

Temperature

» Factors controlling Temp distribution

Distribution of Temp Month of
January-July

Range of Temp Month of January-July

TEST SERIES 2020

» Inversion of Temperature
» Atmospheric Circulation and Weather

Systems

Atmospheric Pressure

Vertical variation of pressure
Horizontal distribution of pressue

World Distribution of Sea Level
Pressure

Factors affecting the velocity and
direction of the Wind

Pressure Gradient Force
Frictional Force
Coriolis Force

Pressure and Wind ( Cyclonic &
Anticyclone Circulation)

General Circulation of the Atmosphere
- Pattern of Planetary Winds
Latitudanal Variation of Atmospheric
Heating

» Emergence of Pressure Belts
» Migration of Belts Following apparent

YV VvV VvV VvV VY VY vV VY VY

PRELIMS COMPLETE REVISION TESTS

Path of Sun

Distribution of continents & Oceans
Rotation of the Earth

Circulation

Simplified Global Circulation - Hadley
Cell, Ferrel Cell

Seasonal Wind

Local Wind

Land and Sea Breezes
Mountain and Valley Winds
Air mass & fronts

Extra Tropical Cyclone
Thunderstorms

Tornadoes

Water in the Atmosphere
Water Vapour

o Humidity - Absolute and Relative




o Saturation - Dew Point
o Evaporation and Condensation

» Precipitation

o Rainfall, Snowfall, Sleet Hail,
Hailstones

o Dew
o Frost
o Fog & Mist

» Clouds

o Types - Cirrus, Cumulus, Stratus,
Nimbus

High - Cirrus, Cirrostratus,
Cirrocumulus

Middle — Altostratus, Altocumulus

Low - Stratocumulus,
Nimbostratus

Vertical Development - Cumulus
and Cumulonimbus

» Types of Rainfall

o Conventional
o Orographic
o Cyclonic

» World Distribution of Rainfall
» World Climate

o The Hot, Wet Equatorial Climate

o The Tropical Monsoon and Tropical
Marine Climates

The Savanna or Sudan Climate

The Hot Desert and Mid-Latitude
Desert Climates

The Warm Temperate Western
Margin (Mediterranean) Climate
The Temperate Continental
(SteppClimate

The Warm Temperate Eastern
Margin (China TypClimate

The Cool Temperate Western
Margin (British TypClimate

PRELIMS COMPLETE REVISION TESTS
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o The Cool Temperate Continental
(Siberian) Climate

o The Cool Temperate Eastern
Margin (Lauren-tian) Climate

o The Arctic or Polar Climate

OCEANOGRAPHY

» Water on the Surface of the Earth
» Hydrological Cycle

o Component
o Processes

» Oceans
» Relief of the Ocean floor
» Divisions of the ocean floor

Continental Shelf
o Continental Slope
o Deep sea plain
e Oceanic deep and Trenches
Minor relief features
e Mid oceanic ridges
e Seamount
o Submarine canyons
e Guyouts
o Atoll

Temperature of the Ocean Water
o Vertical

o Spatial

o Factors affecting Temperature
distribution

o Latitude

o Unequal distribution of land &
Water

o Prevailing wind
o Ocean Currents

» Horizontal & Vertical Distribution
» Salinity of the Ocean Water

o Factors affecting salinity




Evaporation and precipitation

Fresh water flow from rivers

Ocean currents

o Horizontals distribution of sailinity
o Vertical Distribution of salinity
Density of Ocean Waters

» Movements of ocean Water

Factors influencing Movement
o Temperature

o Salinity

o Density

Motion — Horizontal and Vertical
Currents

Waves

e Motion of waves and water
molecules

Characteristics of wave
Crest and Trough
Height

Amplitude

Period

Length

Speed

Frequency

Tides

o Relation between Gravitional
Forces and Tides

o Tidal currents
o Types of Tides

Based on Frequency - Semi Diurnal ,
Diurnal, mixed

Based on SME position - spring and
Neap Tides

o Importance of Tides
Ocean Currents

o Primary Force that initiates the
movement

Heating of solar energy

® 06 06 06 06 06 06 0

PRELIMS COMPLETE REVISION TESTS
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» Wind
» Gravity
» Coriolis force

o Secondary force that influence the
currents to flow

o Types of ocean curents:

o Surface currents & Deep water
currents based on Depth

o Cold and Warm Currents based on
Temperature

» Major Ocean currents of the World
» Effects of Ocean Currents

Water Resources

» Underground water resource
» Surface water resources

Inland water resources: Utilization of
inland water resources

Oceanic Water Resources
Utilization of oceans by man
Water consumption patterns
Water Pollution

Conservation of Water Resources
Techniques of Water Conservation

BIOGEOGRAPHY

» Soil Characteristics

Factors Responsible for Soil
Formation

Stages of Soil Formation

Soil Forming Processes

Soil Profiles and Horizons
Soil Classification

Soil Erosion and Conservation
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Land-use » Economic utilization of forests
Land capability classification » Deforestation

Causes of Land Degradation

Impact of Land Degradation

Steps taken by GOI

Sustainable Land Management
Vegetation Resources

Types of natural vegetation

Forests

Significance of forests

(0]

(0]
(0]
(o]

(0]

(0]

Deforestation in tropical forests
Deforestation in temperate forests
Rate and extent of deforestation

Causes and factors of
deforestation: Immediate causes
of deforestation

Indirect deforestation
Underlying causes of deforestation

significance
o Cultural significance
Factors of forest development
Extent of forest cover
Classification of forests
o Grasslands
o Desert vegetation
o Tundra Vegetation

*kkkkkkkkk

(0]

Forest conservation strategies

o Reforestation
e Monoculture plantation
o Afforestation

» Types of forestry

o Social forestry
o Agro-forestry

PRELIMS COMPLETE REVISION TESTS
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FUNDAMENTAL OF GEOGRAPHY - 2

TEST: 7

INDIAN GEOGRAPHY
(INDIAN PHYSIOGRAPHY + DRAINAGE SYSTEM

+ INDIAN CLIMATE + SOILS IN INDIA + NATURAL
VEGETATION)

Physiography of India
» Geological Region
» Location
» Physiographic Sub-Units
o Himalayans
e Northern Plains
o Peninsular Plateau
o Thar Desert
o Coastal Plain
0]

The Islands
Mountain System
o Classification of The Himalayan
System
o Regional Division of the Himalaya
The Peninsular - Peninsular Plateaus
Plains - Northern Plains of India
Lakes
Deserts
Indian Coasts and Islands

Drainage System

Classification of Drainage
Himalayan Drainage

Indus river system

Indus drainage system

Ganga River System
Brahmaputra river system
Peninsular River System

East flowing Rivers

Mains Rivers and their tributaries
Famous cities and river banks

YV V VYV VYV Y Y VY VYV VY

4.

PRELIMS COMPLETE REVISION TESTS

CLIMATE

» Factors influencing the climate of India
» Monsoon
» Mechanism of the Monsoon

o Classical Theory

o Modern theory

o Air mass theory
Jet stream theory

EI-Nino and La-Nina

Seasonal rhythm

Koppen's Climatic classification
Indian Droughts and Floods

Soils in India

Soil Acidity

Soil textures
Minerals of Soil
Soil Erosion

Soil Conservation

Natural Vegetation

» Vegetation

» Mangroves

» Distribution of Forest Area
» Forest Problems in India
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FUNDAMENTAL OF GEOGRAPHY -3
HUMAN & ECONOMIC GEOGRAPHY

TEST: 8 (DEMOGRAPHY + CENSUS + ECONOMIC ACTIVITIES
+ AGRICULTURE + MINERALS + ENERGY INDUSTRY +
TRANSPORT + TRADE + COMMUNICATION)

Demography

Concept of human resources
Population distribution
Physical factors
Socio-cultural factors
Demographic factors
World population distribution
e Ecumene
e Non-ecumene
Continent-wise distribution of
population

» Density of population

» Pattern of population density 2.

» Population increase (growth) in the
world

Causes of rapid increase in population
Future projections
Determinants of population growth
Natural increase
Characteristics of population
o Age composition
Population pyramids
e Sex composition
o Literacy
Theories of population growth
o Malthusian theory
e Marxian theory
o Demographic Transition Theory
Optimum population

PRELIMS COMPLETE REVISION TESTS

o Over-population
o Under-population
Population problems

o Population problems of developing
countries

o Population problems of developed
countries

» Population Policies: of China, of India.
» Various types of rural settlements

» Relationship between house types
with relief, climate and building
materials

Urbanization

» Basic Feature and Pattern’s of India’s
Urbanization

Issues of Urbanization in India
o Rural Urban Migration
Emergence of Slums
Urban Transport
Waste Disposal

Water Supply, Drainage and
Sanitation

Electronic Waste
Urban Poverty

Real Estate (Regulation &
Development) Bill

Way Forward to Tackle Issues Related
to Urbanization

o Inclusive Cities/Smart cities
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o Recent government programmes:

AMRUT, HRIDAY Scheme

» Migration

Displacement

» Importance of the Rehabilitation

Policy
Urban settlements: types

» Morphology of urban settlements

Migration: Push factors and pull
factors

Emigration during colonial, post-
independent and post-liberalisation
period

» Functional classification of cities
» Difference between boundaries and

frontiers, their classification

Rural urban fringe characteristics,
advantages, problems

» National urbanisation policy

Factors affecting rural settlements,
their types and patterns

Census

vV VYV VYV VYV VY VvV VY

Literacy

Sex Ratio

Family Planning

Old Age

Age Structure

Density

Population Growth
Census Terminologies

Mineral resource

>
>
>
>

Types of minerals
Metallic minerals
Non-metallic mineral

Distribution of minerals and mining
regions

YV V VYV VYV VY Y VY VY VY VY VY VY VY

>

Distribution, production and
international trade of Metallic
minerals: Ferrous metals: Iron ore

Ferro-alloys and non-ferrous
Manganese

Chromium

Nickel

Tungsten

Antimony

Copper

Bauxite and Aluminium
Zinc; Lead

Tin

Gold

Silver

Platinum

Mineral chemicals

o Mica

o Potash

o Phosphate
o Nitrates

o Sulphur

Conservation of mineral resources

Energy resources

» Classification of energy
» Production of conventional energy
» General trends of energy production

and consumption

» Reserves and sources of energy
» Coal

PRELIMS COMPLETE REVISION TESTS

o Nature and origin of coal

o Constituents and kinds of coal
o Coal fields and coal production
o By products of coal

o Conservation of Coal
Petroleum
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Nature and properties of petroleum
Origin and recovery
Exploration
Petroleum refining
Petroleum reserves
Producing areas
Consumption of petroleum
International trade
OPEC and its role in oil trade
» Natural gas: Reserves and Production
» Hydro-electricity
o Advantages of hydro-electricity

o Ideal conditions for generation of
hydro-electricity

Distribution of potential hydro-
power

Hydro-electric power generation in
India

Atomic (nuclear) energy

o Atomic: source minerals: Uranium
World distribution of Uranium
Production of Uranium
Thorium

Production of Atomic (Nuclear)
Energy

o Nuclear Energy

Alternative (non-conventional)
sources of energy

Solar energy

Wind energy
Geothermal power
Tidal energy

Wave energy
Biomass energy

®© 06 0 06 06 06 06 606 0

6. Industry

» Industrial development

PRELIMS COMPLETE REVISION TESTS

» Iron and Steel Industry

o Location of iron and steel industry
Early localization
Development of iron manufacture

Distribution of iron and steel
industry

o Global steel production
o International trade

o Growth potential of the steel
industry

Textile Industry

o Cotton Textile Industry: Location of
the industry

o Recent trends in localization

o Distribution and production of
cotton textiles

Woollen textile industry: Location
of the industry

Silk textile industry: Raw silk
manufacture

Synthetic (artificial) silk industry:
Distribution of man-made fibre and
fabrics.

Engineering Industries

o Machine tools and machines:
Areas of production

Industrial machinery: Textile
machinery

o Other industrial machinery
o Agricultural machinery
Manufacturing of transport
equipment

o Automobile industry

o Railway car and locomotive
industry

o Shipbuilding
o Aircrafts Industry

» Chemical Industry & Fertilizer

o Classes of chemicals: Branches of




chemical industry

Heavy chemical industry
Production of acids and alkalies
Rise of chemical industry

Fertilizer industry: Nitrogen
fertilizers

o Phosphate fertilizers
o Potash fertilizers
Explosives

» Glass industry: Production of glass

Agro-industries
o Synthetic rubber industry

o Pulp and paper industry: Essential
conditions for pulp production

o Production of paper and paper
board

o Newsprint
Cement industry
o Distribution of cement industry

o Recent trends: Main global
competitors

Petroleum refining industry:
Localization

o Site selection of petroleum
refineries

o History of oil refineries

o World pattern of oil refining
o Petroleum products
Industrial Regions

o Characteristics of industrial
regions

o Delimitation of an industrial region

o Principal industrial regions of the
world

Industrial regions of Anglo America—
USA, Canada, Western Europe and
Central Britain, Germany, Belgium,
Netherlands, France, Italy, Eastern
Europe, Poland, Former USSR

>

TEST SERIES 2020

Eastern Asia—Japan, China, the
‘Dragons’, India, High tech patterns.

Transport

>

Importance and development of
transport

» Means of transport
» Transport costs and economic

distance

» Operating costs in transport
» Relative importance of means of

transport: Railways, Roads, Pipeline,
Oceans, Air transport

» Profits and freight rates
» Government's transport policy
» Transport patterns in the world:

Oceanic transport

Ocean transport routes

Inland waterways

Main regions of inland waterways

Railways: Factors affecting the
railroads

» Distribution of railroads in the world
» Air transport: Factors influencing air

transport

» Air transport in various continents
» Pipeline transport

o Petroleum (oil) pipelines
o Gas pipelines

Basic terms related to
Agriculture

>
>
>
>

PRELIMS COMPLETE REVISION TESTS

Performance of the agriculture sector
Types of farming in India

Dry zone farming

Organic farming

Cropping seasons in India




Cropping Pattern in India
Agriculture regionalization

Infrastructure factors: Seeds;
Fertilizers; Irrigation

Land use pattern in India
Institutional Factors as land reform
Horticulture sector in India
Agricultural revolutions
Agricultural labours

Price Policy for Agriculture
Agricultural marketing

Agricultural Insurance

Agricultural Census

Major schemes in agricultural sector
National Policy for farmers

Impact of climate change on
agriculture

What is sustainable agriculture?
Use of IT in agriculture
» Agriculture Issues and Challenges

YV vV VYV VYV VY VY VY VY VY VY VY

Productivity of Crops and
conditions for growth

» Wheat

o Conditions of growth
o Varieties

o Types of cultivation
o Production pattern
o International trade
Rice

o Conditions of growth
o Varieties

o Methods of cultivation
e Production pattern
o International trade
Maize (Corn)

o Conditions of growth

PRELIMS COMPLETE REVISION TESTS

all 62020

e Production pattern
o International trade
Barley

o Conditions of growth
e Production pattern
o International trade
Oats

Rye

Beverages

Tea

o Condition of growth
e Production pattern
o International trade
Coffee

o Types of coffee

o Conditions of growth
e Production pattern
o International trade
Cocoa

o Conditions of growth
e Production pattern
o International trade
Tobacco

o Conditions of growth
o Production pattern
o International trade
Fibre Crops

» Cotton

o Varieties of cotton

o Conditions of growth

e Production pattern

o International trade

Jute

o Conditions of growth

e Production pattern

o International trade

o Substitutes of Jute: Flax, Hemp
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» Raw Silk
o Production pattern
o States
» Natural Rubber
o Other sources of rubber
o Plantations in South-East Asia
o Production pattern
» Sugarcane

Conditions of growth

Production pattern

International trade
Sugarbeet—Conditions of growth
Production pattern

Sugar industry

Sugar consumption

International trade.

® 6 6 6 6 6 606 o0
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PRELIMS COMPLETE REVISION TESTS
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TEST: 9

FUNDAMENTAL OF ENVIRONMENT - 1
(ENVIRONMENT + ECOLOGY + BIODIVERSITY)

Ecology

vV V VvV VYV VvV VvV VY

vV V VYV Y Y VYV VY VY VY VY

Types of Ecology
Ecological Hierarchy
Scope of Ecology

Habitat & Ecological Niche
Deep vs Shallow Ecology
Ecological Principles
Ecological Community

Structure and Characteristics of a
Community

Stratification

Ecotones

Ecological Dominance

Seasonal and Diurnal Fluctuation
Periodicity

Interdependence

Ecological Succession

Types and Process of Succession
Climax Community

Range of Tolerance , Maximum Range

Difference between Ecology,
Environment and Ecosystem

Ecosystem and its dynamics

Ecosystem Definitions

Functions and Properties of
Ecosystem

The Structure/Components of
Ecosystem

o Abiotic Components

o Biotic Components
Ecosystem Dynamics

o Flow of Energy in Ecosystem

4.

PRELIMS COMPLETE REVISION TESTS

Trophic Levels
Food Chain
Types & Significance of Food Chain
Food Web
Models for Energy Flow
Ecological Productivity
o Ecological Pyramid

» Biomagnifications

» Biological Control

» Organic Farming

Biogeochemical Cycles

Parts of a Bio Geochemical Cycle
Types of Biogeochemical Cycle
Carbon Cycle

Nitrogen Cycle

Phosphorus Cycle

Sulphur Cycle

Biomes: Forest, Grassland,
Mountain, and Desert
Ecosystems

» Biome

» Grasslands
» Tundra

» Deserts
>
>

Thar desert
Mountain biome

Aquatic Life Zones: Ocean,
Rivers, Lakes, and Wetlands
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>
>
>
>
>
>
>
>
>
>
>
>
>
>
>
>

>

Aquatic ecosystems

Basic facts about the ocean
Importance of the ocean
Zones of the ocean

Marine life

Coral reefs

Coral reefs in India

Conserving coral reefs
Mangroves

Mangroves in India

Freshwater in India
Importance of lakes

National Lake Conservation Plan
Wetlands and their importance
Ramsar Convention

Ramsar Sites

Montreux Record

Extent and distribution of wetlands in
India

Conserving the wetlands of India

Biodiversity Basics

YV VYV VYV Y VY Y VY VY VY VY VY VY VY VY

Biodiversity

Important kinds of biodiversity
Degree of diversity in an ecosystem
Endemic species

Keystone species

Indicator species

Invasive species

Allopatric and sympatric speciation
Bioinformatics

Biodiversity distribution

Uses and values of biodiversity
State of global biodiversity

Threats to biodiversity

Biodiversity Hotspots

Eco-regions

PRELIMS COMPLETE REVISION TESTS

Role of traditional knowledge in
biodiversity

Biopiracy

Extinction of species

Mass extinction

IUCN’s classification scheme

IUCN Red-List of Threatened Species
Level of biodiversity in India
Biogeographic classification of India

Biodiversity Conservation

Ex-situ aid in-situ conservation

Seed banks

Zoos in biodiversity conservation
Botanical gardens

Protected areas

State of protected areas in the world

UNESCO Man and the Biosphere
Program (MAB)

Characteristics of biosphere reserves

International agreements for
biodiversity conservation

Convention on Biological Diversity
Cartagena Protocol

Nagoya Protocol

Aichi Biodiversity Targets

Important Coastal and Marine
Biodiversity Areas of India

Important Bird Areas (IBAs) of India
Global Tiger Initiative

Project Tiger

Project Elephant

Indian Rhino Vision

Recovery Programme for Critically
Endangered Species

Use of indigenous knowledge for
conserving biodiversity

Seed village
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FUNDAMENTAL OF ENVIRONMENT - 2

(ENVIRONMENTAL POLLUTION AND MANAGEMENT
+ CLIMATE CHANGE + GLOBAL WARMING +
ENVIRONMENTAL GOVERNANCE)

TEST: 10

» International Laws on Mining
» Main Act or Statue to regulate the

Effect of Human Activities on
Environment

» Effect of Modern Agriculture on
Environment

» Effect of Housing on Environment

» Effect of Power Generation on
Environment

Effect of River Valley Projects (Water
Resource Projects) on Environment

» Effect of Mining on Environment

» Effect of Transportation Activities on
Environment

» Effect of Tourism on Environment

Water Resource degradation

» Water Cycle (Hydrological Cycle)

» Availability and Quality Aspects
(groundwater depletion)

» Water-borne and Water-induced
Diseases

» Fluoride Problem in Drinking Water
» Arsenic Problem in Drinking Water

Minerals & Environmental
Degradation

Mining and Environment
Sensitivity of Select Ecosystems to
Mining

Impact of Mining

Indirect Impact of Mining

impact of Indian Mining Sector
Sustainable Mining

Deforestation

» Causes of Deforestation
» Implications of Deforestation for Climate

Change

Consequences of Deforestation on the
Wildlife of India

Impact of Deforestation on Indian
Monsoon

» Impact of Deforestation on People

Deforestation Leads to Water and Soil
Resources Loss and Flooding

» Economical Impacts
» Strategies for Reducing Deforestation
» Government Programmes for

>

Conservation of Forests

Legislations for Conservation of
Forests using People Participation

Steps for Improving People
Participation in Forest Resource
Management

Use of Local Traditional Methods

Waste Management

>

) 3

>

PRELIMS COMPLETE REVISION TESTS

Solid Waste
Hazardous Waste
e-Waste
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» Bio Medical Waste o Sources of Thermal Pollution
» Plastic Waste o Effects of Thermal Pollution
» Methods for Waste Management o Control of Thermal Pollution
» Effects of Poor Waste Disposal Soil Pollution or Land Degradation
» Landfill e Sources of Soil Pollution

o Effects of Soil Pollution
Sustainable Development o Control Measures
» Noise Pollution
» Air-borne Diseases

Toxic Substances: Toxicant, Toxicity
and Toxicology

» Factors affecting toxicity
» Carcinogens

» Principles of sustainability

» Measurement of Sustainability or
Sustainable Ethics or Equitable
Utilisation of Natural Resource

Sustainable Lifestyle (Role of
an individual in sustainable,

development) .
Challenges to Sustainable Solid Waste Management

Development

International Efforts to Achieve
Sustainability

» Sources of Solid Waste
» Effect of Solid Waste
» Control Measures of Solid Waste
» Solid Waste Management Rules
» Hazardous Waste Management
» Air Pollution (HWM)
o Sources of Air Pollution
Effects of Air Pollution Coastal ecosYStem
Classification of Air Pollutant management
Control Measures of Air Pollution » Mangroves

Air Pollution Disasters o Salient features of Mangroves

Environmental Pollution

»

Long Range Transport of Gaseous
Air Pollutants

National Ambient Air Quality
Standards

Water Pollution
Sources of Water Pollution
Types of Water Pollutants
Effects of Water Pollution
Water Quality Standards
Control of Water Pollution
hermal Pollution

PRELIMS COMPLETE REVISION TESTS

Importance of Mangroves
Mangroves in India
Mangroves under threats

Legal and Regulatory Approaches
for Protection

Estuaries

o Importance of estuaries

o Threats to estuaries

Coral Reefs

o Geographical Conditions Required
o Uses of coral reefs
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o Conservation of coral reef

Steps for Coastal Ecosystem
Management

Environmental Impact
Assessment

>
>

>
>

Government Body which Executes EIA

Environmental Effects Analysed under
EIA

Process of EIA
EIA Ruling 1984

Environmental Laws

» Environmental Laws
» Provisions in the Indian Constitution

towards Environmental Protection

Salient Features of Air (Prevention
and Control of Pollution) Act,1981*
Salient Features of Water (Prevention
and Control of Pollution) Act, 1974

Salient features of Forest
Conservation Act, 1980

Salient Features of Wildlife Protection
Act, 1972

Salient Features of Environment
(Protection) Act,1986

Role of Government in Environmental
Protection

Environment related
Institutions and
Organizations

>
>
>
>

Pollution Control Boards
National Green Tribunal
Forest Survey of India
National Board for Wildlife

13. Schemes

» National Mission for Clean Ganga
» India Signs Global Environment

Facility Grant

Wood in Good Campaign

Boat Lab to Study Brahmaputra
Wildlife Action Plan

SECURE Himalayas

Strategic Plan for Human-Elephant
Conflict

» Save the Sparrow
» Land Degradation Neutrality
» Biodiversity Heritage Site - Ameenpur

YV V vV VvV VvV VY VY VY

>

Lake

Energy Conservation Building Code
Special Protection Force for Rhinos
Regional Project on Stubble Burning
Blue Flag Pilot Project

National Afforestation Program
National River Conservation Plan
National Mission for Clean Ganga
National Air Quality Index (AQI)

National Action Programme to
Combat Desertification

Bharat Stage Norms

International Environmental
Governance

PRELIMS COMPLETE REVISION TESTS

UNEP

UNDP

Centre for Biological Diversity
WWEF for Nature

IUCN - Red List

Birdlife International

International Conventions / Protocols
& their Objectives
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15. Urbanization and climate Pollution due to use of chemical
fertilizers

Soil-related effects
Fertilizer's Effect on the Environment
Impact of livestock on environment

Impact of use of Pesticides on
environment

» Pollution in metros and climate
change

Real estate boom and environment
degradation

» Urban Heat Island

> Polythene bags and pollution » Impact of GM crop on environment

> Methane generation from waste » Emission of Methane from agricultural
practices

. Impact of agriculture on » Sustainable Agriculture Techniques
climate

» Agriculture increases Carbon Dioxide 17. Global Warming & Health

Emissions » Health impacts of global warming

» Monoculture practice impacts » Mosquito-borne diseases
biodiversity » 0zone depletion and human health

*kkkkkkkkk

PRELIMS COMPLETE REVISION TESTS
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FUNDAMENTAL OF ECONOMY -1

TEST: 11 (BASIC CONCEPTS OF NATIONAL INCOME, MONEY
: BANKING, AND OTHER PROVISIONS + FINANCIAL
MARKET)

Basic concepts in Economy Inflation

» Basic concepts of Macroeconomics » Types of Inflation

» Economy Sectors » Other variants of inflation

» Classification of Economy » Effects of inflation

> ) 2
»

Basic Characteristics of Indian
Economy

Measures taken by RBI

RBI and Government Monetary Policy

. Committee
National Income

» Concepts of National Income Banking

> Ca|CU|at'°f‘ of Naponal Income » Development of Banking System in
» Latest India’s National Income India

Eshmatgs . o » Reserve Bank of India (RBI)
New Series of National Statistics (Base :
» Public Sector Banks

Year 2011-12) - _
Annual Estimates of Expenditures on » Other Important Banks and Financial

GDP Institutions

Cash Reserve Ratio (CRR)
Statutory Liquidity Ratio (SLR)
Repo Rate

Reserve Repo Rate

Call Rates

Marginal Standing Facility (MSF)
Bank Rate

Banking Sector Reforms in India
Payment banks

Small Banks

New banking licence

White Label ATM

Unified Payments Interface
Bank Board Bureau

Per Capita Income
Purchasing Power Parity
Lorenz Curve

Philip’s Curve

Gini Coefficient

Money

Indian currency system
Broad and Narrow Money
Money multiplier

Digital Money

New Monetary Aggregates
Monetary Policy

Monetary Policy Committee

vV VvV VYV VvV Y Y VYV YV VY VY VvV VYV VY

PRELIMS COMPLETE REVISION TESTS
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>

>

>

Marginal Cost of Funds Based Lending
Rate (MCLR)

Priority Sector Lending Certificates
Concept of Micro ATM

Important committees

Ratan P Watal Committee on Digital
Payment

Committee for Market Infrastructure
Institution (MII)

D. P. J. Nayak Committee

Deepak Mohanty Committee Report
on Medium-term Path on Financial
Inclusion

Narasimham Committee Report on
Banking Sector Reforms

Uday Kotak committee on Corporate
Governance

Nachiket Mor Committee

Indian Financial Market

2

Concept and functions of financial
markets

» Importance of money market

Types of capital market

» Distinguish between capital market

and money market

» The stock exchanges in India

Nature and functions of a stock
exchange

» Advantages of stock exchanges
» Limitations of stock exchanges

Insurance Industry - Insurance Industry
and Reforms

Financial Regulators - Role of SEBI &
IRDA

8.

>

Miscellaneous

Government to recapitalize the PSB’s
over the next 2 years

New RBI rule and regulation for peer to
peer (P2P) lending

Domestic Systematically Important
Banks (SIBs) of India

» Financial Inclusion in India
» The Concept of Bad Bank

Alternative Mechanism Panel for PSB
consolidation

Employee Provident Fund of India
Enforcement Department In RBI

Gold Monetization Scheme (GMS)
Indian Post Payment Bank (IPPB)

Indian Gold Coins/Gold Bullion
Scheme

Agriculture

YV VvV VYV vV VY VvV VY

New Agri Project - “Green Ag "
Operation Green

Agri-Market Infrastructure Fund

Kisan credit card

Krishi Kalyan Abhiyan

Kisan Kalyan Pradhikaran

Agriculture Price Policy (APP) in India

Pradhan Mantri Annadata Aay
Sanrakshan Abhiyan (PM-AASHA)

Bhavantar Bhugtan Yojana

» Foodgrain Production to touch a New

Record of 284 83 Million Tonnes in
2017-18

» Sugar Production

Maharashtra Adopt Food Park Model

» Gujarat's first Mega Food Park

PRELIMS COMPLETE REVISION TESTS

inaugurated in Surat

Three Year Action Plan of Agricultural
Education




10. Industry

Department for Promotion of Industry
and Internal Trade

National Mission on Government
e-Market (GeM) portal

Integrated Scheme for Development of
Silk Industry” for sericulture

North East Industrial Development
Scheme
(NEIDS)

» Government Redefines MSME
» Udyam Sangam-2018 inauguration

» ‘One District One Product’ Summit
inaugurated

Pharma Promotion Tax Exempt:
Tribunal

Cabinet Identified Champion Services
Sectors

» Purchasing Managers' Index (PMI)

» Department of Commerce Developing
National Logistics Portal
National Entrepreneurship Awards
2018

Incredible India Tourist Facilitator
Certification

Infrastructure

» Western Dedicated Freight Corridor
(WDFC)

» First Freight Village

» Bidder Information Management
Systems (BIMS)

Bhoomi Rashi - PFMS linkage
National E-Mobility Programme
Draft National Automotive Policy

Advanced Motor Fuels Technology
Collaboration Programme

PRELIMS COMPLETE REVISION TESTS
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Railways CONCOR begins coastal
operations

Air Sewa-20

» Airports Privatization
» Drone regulations developed by

Ministry of Civil Aviation

» Water Aerodrome
» NABH (Nextgen Airports for Bharat)

Nirman Initiative

» Bansagar Canal Project
» Jal Marg Vikas Project
» National Waterways projects in North

Eastern Region (NER)

Declaration of irrigation projects as
National
Projects

Portal launched for real-time
information on National Waterways

Revised PPP Port Concessions
Solar Charkha Mission

Patratu Super Thermal Power Plant
National Energy Storage Mission
Kudankulam Nuclear Power Plant
(KNPP)

Srinagar - Alusteng - Drass - Kargil -
Leh Transmission System

» Development of renewable energy
» Additional Strategic Petroleum

Reserves established
TRAI Interconnect Rule

» The TRAI launches integration &

availability of TRAI Mobile Apps on
UMANG platform

Cabinet Approves Easing of Spectrum
Cap

» Strategic Investment Fund under NIIF

O-SMART scheme




TEST SERIES 2020

12. Banking & Financial Sector

» Central Board of RBI

» Monetary Policy: A Fine Balance
between Growth and Inflation

RBI to link interest rates to external
benchmarks replacing MCLR

India Post Payments Bank (IPPB)
Banks Board Bureau
New RBI Norms Related to NPAs

Parliament’s Estimates Committee
report on NPA's

Prompt corrective action framework
of RBI

Mehta panel 5-point plan to fight
NPAs

Project Sashakt
Inter-Creditor Agreement (ICA)
Recapitalization of RRBS

Pariwartan’ scheme for power sector
revival

» Companies Act Notified

» The arbitration and conciliation
(amendment) bill, 2018

Fugitive Economic Offenders Bill,
2018

Name and Shame Wilful Defaulters
National Financial Reporting Authority
Public credit registry

Currency in Circulation Improved
Micro ATM

NPCI launched UPI 2.0

RBI allows Tokenization of Card
Transactions

Nilekani Panel on Strengthening the
Digital Payments Ecosystem

The Society for Worldwide Interbank

Financial Tele- communication
(SWIFT)

PRELIMS COMPLETE REVISION TESTS

Independent regulator for the
payments industry

Treasury Bill
Participatory Notes
Development Impact Bonds

Bharat 22 ETF (Exchange Traded
Fund)

Total Expense Ratio

World's First Block-chain Bond
Share Repurchase

Currency Derivative Trade Limit

RBI eases hedging norms for overseas
borrowings

Commercial papers as a source of
funds

» TReDS platform
» Merger of three public sector

insurance firms

Steering committee on fintech related
issues

RBI buys gold for first time in nearly a
decade

» RBI Surplus transfer to Government
» RBI Launches Ombudsman scheme

for NBFCs

Government Owned Non-Banking
Financial Corporations (NBFCs)

Khan Committee recommendation on
FPI

Graded Surveillance Measure

» Pension Fund Regulatory and

Development Authority

Board of Management for
Cooperative Banks

Deposit Insurance and Credit
Guarantee Corporation

Reasons for fall of Rupee
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FUNDAMENTAL OF ECONOMY - 2

TEST: 12 (EXTERNAL SECTOR + INTERNATIONAL INSTITUTES
. + MONEY, BANKING FINANCIAL MARKET AND OTHER
PROVISIONS)

1. Government Budgeting/ 4. Planning

Deficits > Objectives - Major Objective of
Planning

Planning History
o Regional and National Planning
o Imperative and Indicative Planning

» Budget
e Plan and Non Plan Expenditure
o Revenue, Nonrevenue

o Receipts, Revenue Receipts, Tax
Revenue Receipts, Non-Tax Revenue o Visvesvaraya Plan, Gandhian Plan
Receipts FICCI Proposal, Congress Plan

Revenue Expenditure Bombay Plan
Revenue Deficit, Fiscal Deficit, Planning Commission and National

Primary Deficit Development Council (NDC)

o Deficit and Surplus Budget Central Planning - 5 Year Plans, 20
» Deficit Financing Point Program, MPLADS

o Decentralizes Planning

Fiscal PO"CY - Revenue o Analysis of 5 Year Plans
» 12" FYP -Targets - Economic

» Tax Structure in India
» Tax - Direct Tax, Indirect Tax

» Methods of Taxation - Progressive,
Regressive Proportional

» Value Added Tax - VAT in India

» Goods and Services Tax - GST, GST
Council

» Service Tax
» DTC - Direct Tax Code

Subsidies

» Food
» Fuel
» Fertilizers

PRELIMS COMPLETE REVISION TESTS

Growth, Poverty and Unemployment,
Education, Health, Infrastructure,
Environment and Sustainability,
Service Delivery

» NITI Aayog and its work

Investment Models

Measures of Investment

Capital and investment

Factors affecting investment
Classification of Investment

o FDI

o Angel Investors and Start-ups
o M&A
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Investment Models

Role of State

PPP (Public-Private Partnership)
Savings and Investment Trends
National Investment Fund (NIF)
Unit Trust of India

Global Depository Receipts/Foreign
Currency Convertible Bonds

Portfolio Investment from Foreign
Institutional Investors

Non-Resident Indian Investments
Mutual Funds
Pension Reforms

Main Features and Architecture of the
New Pension System

Schemes related to Finance

» Make In India
» Pradhan Mantri Garib Kalyan Yojana

» Digi-DhanVyapar/ Lucky Grahak
Yojana

Pandit Deendayal Upadhyay Shramev
Jayate Karyakram

» Pradhan Mantri Jan Dhan Yojana
» Pradhan Mantri Mudra Yojana

External Sector

» Fixed Foreign Currency Market
» Float Foreign Currency Market
» Balance Of Payments

o Current Account

o Capital Account

Foreign Portfolio Investment

o Fll

o FDI

Exchange Market

o LERMS

YV VYV VYV Y VY VY VY VYV VY VY

o NEER

o REER

o EFF

e Purchasing Power
Depreciation
Appreciation

Hard currency

Soft currency

Cheap currency

Dear currency

SEZ

Convertibility of Currency
India’s Forex Reserves
GAAR

Foreign Trade Policy

International Organizations

» United Nations
» Food and Agriculture Organization

(FAO)
International Civil Aviation
Organization (ICAO)

International Fund for Agricultural
Development (IFAD)

International Labour Organization
(ILO)

International Maritime Organization
(IMO)

» International Monetary Fund (IMF)

International Telecommunication Union
(ITU)

United Nations Educational, Scientific
and Cultural Organization (UNESCO)

United Nations Industrial
Development Organization (UNIDO)

» Universal Postal Union (UPU)
» World Bank Group (WBG)
» International Bank for Reconstruction

PRELIMS COMPLETE REVISION TESTS
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and Development (IBRD) » New Development Bank

(IFC)

International Development Trad t
Association (IDA) . Irade agreements

World Health Organization (WHO) > RCEP

» World Intellectual Property Organization
(WIPO)

World Meteorological Organization NAFTA

(WMO) MERCOSUR
World Tourism Organization (UNWTO)

World Trade Organization (WTO)
Asian Development Bank
Asian Infrastructure Investment Bank

PP

» Southern African Development
Community (SADC)

ASEAN

(All SAFTA
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PRELIMS COMPLETE REVISION TESTS
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TEST: 13

FUNDAMENTAL OF SCIENCE - 1
(BIOLOGY + EVERYDAY SCIENCE)

BIOLOGY

1. Chemical Building Blocks of
Life

History and Origin of Life

Cells

Cell Structure
Membranes

Cell-Cell Interactions
Energy and Metabolism
Respiration
Photosynthesis

How Cells Divide
Sexual Reproduction

vV VvV Vv VvV VvV VY VY

Genetics

» Inheritance

» DNA, The Genetic Material

» Gene Expression

» Gene Regulation

» Mutation

» Recombinant DNA Technology

Classification of Living
Things

» Classification and Domains of Life
» General Biology/Classification of

PRELIMS COMPLETE REVISION TESTS

Living Things/Viruses
» Prokaryotes
» Eukaryotes
o Protists
o Plants
o Fungi
o Animals

Evolution

» Evolution of Life
» Animal Evolution
» Human Evolution

Tissues

» Epithelial tissue
» Connective tissue
» Muscle tissue

Endocrine system

Hypothalamus

Pineal body (epiphysis)
Pituitary gland (hypophysis)
Thyroid

Adrenal glands

>
>
>
>
>
>

Reproductive glands

Respiration

» External and Internal Respiration
» Respiratory system in Plants
» Respiratory System in Insects
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> Respiratory System in Humans and 13. Excretion, Osmoregulation

Animals

. The Transport System in
Organisms

Transport system in a Cell
Transport System in Plants
Transport System in Animals
Blood Vascular System

The Lymphatic System

. Skeletal and Muscular
Systems

Bone and Skeleton System (Osteology)
Ligaments (Syndesmology)

Muscular System (Myology)
Vertebrates

. Reproduction

Asexual Reproduction in Plants
Asexual Reproduction in Animals
Sexual Reproduction in Plants
Sexual Reproduction in Animals
Sexual Reproduction in Humans

and Thermoregulation

Excretory products
Excretion in plants
Excretion in Animals

Osmoregulation, ADH and formation
of Urine in Animals

Physiological and Behavioural
Adjustments

. Nutrition

» Classification by Source of Energy and
Carbon

Plant Nutrition
Animal Nutrition
Human Diet

The Digestive System

. Economic Zoology

» Beneficial animals: Corals - Earthworm
- Vermiculture - Beneficial insects
- Prawns - Lobsters - Crabs - Pearl
oysters - Fishes - Guano - Aquarium -
Vivarium.

» Harmful animals: Disease causing
organisms - Vectors - Poisonous
organisms - Fouling organisms -
Pests.

*kkkkkkkkk

PRELIMS COMPLETE REVISION TESTS
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FUNDAMENTAL OF SCIENCE - 2
SCIENCE & TECHNOLOGY

(BIOTECHNOLOGY + HEALTH + DEFENCE + SPACE
+IT + TELECOM + IPR + NANOTECH + ROBOTICS +

NUCLEAR TECH)
BIOTECHNOLOGY

1. Genetics and biotechnology

TEST: 14

Waste water and sewage treatment
Landfilling technologies
Composting

» Industrial genetics

» Protoplast and cell fusion
technologies

Genetic engineering

DNA sequencing

Nucleic acid probes
Genomics and proteomics
Antisense and RNA interfence

Potential laboratory biohazards of
genetic engineering

» Bioprocess/fermentation technology

Biological fuel generation

» Global warming and the significance
of fossils fuels

Photosynthesis: the ultimate energy
source

Biofuels from biomass
Bioethanol from biomass
Biodiesel

Methane

Hydrogen

Environmental biotechnology

» Microbial Ecology Environmental
Biotechnology

PRELIMS COMPLETE REVISION TESTS

Bioremediation
Detect and monitoring of pollutants

Microbes and the geological
environment

Environmental sustainability and clean
technology

Plant and forest
biotechnology

» Plant biotechnology
» Forest biotechnology

Animal and insect
biotechnology

» Genetic manipulation and transgenic
animals

Genetically engineered hormone and
vaccines

» Animal organs for human patients
» Genetically modified insects

Food and beverage
biotechnology
» Food and beverage fermentations

» Microorganisms as food
» Enzymes and food processing




» Amino acids, vitamins and sweeteners
» Organic acids and polysaccharides

Public acceptance and safety of new
biotechnology foods

Biotechnology and medicine

Pharmaceuticals and
biopharmaceuticals

» Antibiotics
» Vaccines and monoclonal antibodies

» Biopharmaceuticals/therapeutic
proteins

Pharmacogenetics

Molecular biology and human disease
Diagnostics in developing countries
Gene therapy

Systems biology and medicine

Stem cell biotechnology

Protection of
biotechnological inventions

» Patent protection Trade secrets
» Plant breeders’ rights

INSTITUTIONS &
POLICY

India’s policy in the field of the science
and technology

o The S&T policy resolution of 1958
o S&T policy of 1983
o S&T policy of 2003
o S&T policy of 2013
Institutional structure

o Department of Science &
Technology

e CSIR
o Survey of India
o Science and Engineering Research

PRELIMS COMPLETE REVISION TESTS

A vt

Council
o Technology Development Board

o National Accreditation Board
For Testing And Calibration
Laboratories
Science and technology as a source of
Human Resource Development

Awards related to Science

» New Initiatives Aligned with the

National Agenda

India and World collaboration in science
projects

» Technology Vision Document 2035
» National Biotechnology Development

Strategy 2015-2020

National Intellectual Property Rights
Policy

» Organ donation rules in India
» Policy on Synthetic Biology

Types of orbits

Launch Vehicle

Satellite communication in India
INSAT Satellite application
Remote sensing applications
Cryogenic rockets

Global Positioning System

o Galileo

o GLONASS

o IRNSS

o GAGAN

Chandrayaan - 1 &I

Mars Orbitor Mission

Space Organisations

Space race/Space junk

Recent updates

South Asia Satellite: Significance
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» Neutrino Observatory
» Solar Mission- ADITYA
» Gravitational Waves

» Missile system and classification
e On the basis of type
o On the basis of launch vehicle
o Onthe basis of Range
o On the basis of propulsion system
India’s Missile System
Agni
Prithvi
Trishul
Nag
Dhanush
Astra
Prahaar
BrahMos Missile System
Indian Submarines and Naval Ships
Light Combat Aircraft
Unmanned Aerial Vehicle
Stealth technology
Chemical Weapon
Biological Weapon

IT, ELECTRONICS &
TELECOM

Computers

o Generation of computers

o Computer terminologies

o Supercomputer and its applications
» Information technology

e Components of IT

o IT enabled services

PRELIMS COMPLETE REVISION TESTS

o Application of IT
Display technologies
o Cathode ray
o LCD
o LED
o Plasma Monitors
o OLED
Telecommunications
o Mobile generations
o Smartphone
o Important conceps
Government initiatives
Digital India Initiative
MeghRaj
Code Free for India
E-Kranti
Bharat Net project
Bharat QR
Contemporary debates
o Net Nuetrality
o Internet of Things
o Big Data Initiative and Privacy
o Cyber crime and security

NANO-SCIENCE &
NANO TECHNOLOGIES

What is Nanoscience and
Nanotechnology?

Origination of Nanoscience and
Technology

» Basics of Nanoscience
» Nanomaterials

Applications of nanotechnology

o Nano medicine

e Semiconductors and computing
e Food




Textiles
Sustainable energy
Environment
Transport

Space

Agriculture

Adverse Health and Environmental
Impacts of Nanotechnology

» Social and Ethical Impacts:
» Nano-science and nano-technology in

India

ROBOTICS

» What is Robotics?
» Machine vs Computer vs Robots
» Parts of a Robot

o Controller

e Manipulator

e End Effector

e Sensor
Classification of Robots
o Rolling Robots

o Walking Robots

e Autonomous Robots

» Artificial Intelligence
» Advantages and Disadvantages of

Robot

Applications of Robotics
Industrial Sector
Aerospace
Healthcare Delivery
Outer Space
Exploration

Military Robots
Disaster Areas
Entertainment

® 06 6 06 06 06 o0 o
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o Agriculture
o Domestic work

NUCLEAR ENERGY

Types of nuclear reactions
Nuclear Power Reactor

N-Power Policy of India
Advantages of Nuclear Energy
Disadvantages of Nuclear Energy

Non-energy applications of Nuclear
energy

» Impact of Radiation
» Issue of Radioactive Waste
» Institutions involved in Nuclear energy

>

PRELIMS COMPLETE REVISION TESTS

Development, AERB

Safety standards in Nuclear Power
plants

Nuclear & Radiological Disasters

MISCELLANEOUS

SPACE TECHNOLOGY & EVENTS
o ISRO’s Mission/Programme:
NASA's Mission/Programme:
Other Agencies Missions
Point Nemo
Exoplanet
‘Super-Earth’ in Constellation
Cassiopeia
Galaxy Proto-Supercluster —
Hyperion
Einstein's Theory of Relativity
Einstein's theory
Sun'’s gravity
Einstein Ring
Sunspot Cycle




Method to simulate, predict solar
activity over ten years developed

ISRO is planning to mine Moon

NASA confirms saturns rings will
be gone in million years

New Source of Neutrinos in Space
discovered

Earth has three moons

China unveils ‘Heavenly Palace’
space station

The International Space Station
(ISS) is celebrating its 20th
birthday

Remove DEBRIS

The case for making Pluto a planet
again

Icarus- farthest star

Cosmic Microwave Background
Radiation (CMBR)

Green Propellant
Plan to Prevent Asteroid Attack

Cooperation in the peaceful uses
of outer space

‘EPIC’ planet

Interstellar Mapping and
Acceleration Probe

Atacama Large Millimeter/
submillimeter Array

High Resolution Imaging Science
Experiment

GLONASS of Russia

Pakistan's remote sensing
satellites PRSS-1 and PakTes-1A

Atacama Large Millimeter Array
(ALMA)

World’s fastest man-made spinning
object

India-Based Neutrino Observatory
Human space flight Programme

TEST SERIES 2020

NASA's Kepler Space Telescope
retired

NASA Parker Solar Probe Mission
Dwarf planet ‘The Goblin’ discovery
Space X BFR lunar Mission
Meteorite found in Rajasthan

Unispace Nanosatellite Assembly
& Training programme (UNNATI)

o The Lyrid meteor shower
o RAMA (Reconstituting Asteroids

(0]
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into Mechanical Automata)
Uakitite

Draft Space Activities Bill, 2017
Resource Prospector Mission
GRACE MISSION

Gaofen - 11

» DEFENCE TECHNOLOGY
» India’s Missile Development Program

PrithviSeries
Agni Series
Akash

Nag

Man Portable Anti-Tank Guided
Missile (MPATGM)

Trishul

Brahmos

Ballistic Missile Defence System
Prithvi Air Defence (PAD)
Advanced Air Defence (AAD)
K-15 Sagarika

Dhanush

Shaurya

Nirbhay

Prahaar

Astra

Pinaka Rocket

Made in India’ Artillery boost
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Advanced Towed Artillery Gun
System (ATAGS)

Rustom-2

Offshore Patrol Vessel ICGS
Varaha launched

Vijaya: Indigenously built patrol
vessel commissioned by Indian
Coast Guard

INS Chakra
Scorpene Submarine Programme
Maritime boundary

Vehicle Location Tracking Devices
and Emergency Buttons

LCA TEJAS clears maiden mid-air
refuelling trial

India’s fi rst missile tracking ship
Solid Fuel Ducted Ramjet (SFDR)
Defence Innovation Hubs

India’s fi rst indigenous anti-nuclear
medical kit

Defence Industry Corridor
Bhabha Kavach
Mission Raksha Gyan Shakti

Intermediate Range Nuclear Forces
Treaty, 1987

HEALTH & BIOTECHNOLOGY
Rare Diseases
Thalassaemia
Down Syndrome
New Classifi cation of Diabetes

Maturity-Onset Diabetes of the
Young (MODY)

Lymphatic Filariasis

New Infl uenza Research
Programme

Drug-resistant Superbug Spreading
Zoonotic Diseases

Nipah Virus

PRELIMS COMPLETE REVISION TESTS

o Lassa Fever
o Nepal, fi rst country in South-East

Asia to Eliminates Trachoma
Measles Rubella Vaccination
Zearalenone, a fungal toxin
Oxytocin

WHO Publishes Essential
Diagnostics List

Generic Drugs: New Rules Soon for
Labelling

Fixed Dose Drug Combinations
(FDCs)

World’s fi rst Bio-electronic
medicine

o 5th Global Forum on TB Vaccines
o Drug Eluting Stents
o Dual Mechanism for Embryonic

Stem Cells to Maintain
Pluripotency

Scientists Grow Human
Oesophagus in Lab

Three-Parent Babies Permitted in
UK

New Sheep Insemination
Technique

Mass Embryo Transfer
CRISPR Technology
Telerobotic Surgery
Bionic mushrooms

Biosensor Technique to Detect
Chikungunya Virus Mitra Clip
Blockchain Technology in Drug
Supply-chain

Rosehip neurons: The newest
neuron in the human brain

Nerve Agent

o WHO called for the Elimination of

the so-called ‘One Centimetre Per
Hour' Benchmark
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Earth BioGenome Project
100k Genome Asia Project
Human Microbiome

Integrated Health Information
Platform (IHIP)

Eat Right India Movement
Food Fortifi cation

Transgenic Rice with Reduced
Arsenic Accumulation

Fighting Fake Drugs through
Blockchain

Project Dhoop

o Eliminate Trans-fats by 2022

® 6 06 06 06 06 o0 o0

©

New Norms for Labelling Packaged
GM food

Animal-Free Testing for Drugs
Elysia chlorotica

Quadrivalent Infl uenza Vaccine
Fortifi ed Rice

Coloured X-Ray on Human

‘P Null’ Phenotype

Bacteria Wolbachia

Affordable Water Disinfection
System- Oneer

Bisphenol A (BPA)

INFORMATION TECHNOLOGY &
COMPUTERS

©

Cyber-Physical System
BullSequana Supercomputer
National Supercomputing Mission
Pratyush Computer

SpiNNaker - World's Largest Brain
- Like

Supercomputer

o Shakti - India’s fi rst indigenous

Microprocessor

India’s First Locally Developed 4G/
LTE Telecom System

PRELIMS COMPLETE REVISION TESTS

e 5G

[IT — Delhi launches fi rst 5G Radio
Lab

Open Transit Data Platform
Three Factor Authentication
Facial Authentication Working

First in Asia: Facial recognition
technology at

Bengaluru airport

Digital Sky Platform
M2M’'Communication

Mobile Towers are harmless: CPCB

Adoption of Blockchain Technology
to Stop Bank Frauds

India’s First Blockchain District in
Telangana

NASSCOM unveils centre for Data,
Al

Mumbai to have India’s First
Artificial Intelligence Centre

Model International Center for
Transformative Al (ICTAI)

Saposhi
GravityRat Malware
ToneTag

World Congress on Information
Technology

NIFTEM

Scutoid: A New Shape Discovered
Concept of Living Will
ALTERNATIVE TECHNOLOGIES
Methanol as cooking fuel

Gas Hydrates or Flammable Ice:
World's fi rst hydrogen train

Repurposed Used Cooking Oil
(RUCO)

Hydrogen-CNG




Europe’s fi rst solar panel recycling
plant

Bengaluru Maps its Solar Wealth
Shakti Shala Solar Park

Global Centre for Nuclear Energy
Partnership

Apsara - U Reactor

Experimental Advanced
Superconducting Tokamak (EAST)

World's fi rst Hyperloop passenger
capsule unveiled

Hyperloop between Mumbai and
Pune

Aerogel- Super-insulating gel
Thermal Battery

India’s fi rst coal-gastifi cation
fertilizer plant

o Quadricycles

NANO TECHNOLOGY
o Graphene

o lIT-Madras unveiled word's fi
rst remotely operable LEAP
microscope

Particle Decay
Rydberg Polarons
KATRIN Experiment

Cyclone-30 India’s biggest
cyclotron facility becomes
operational

SCHEMES & INITIATIVES

o Prime Minister’s Science
Technology And

Innovation Council (PM-STIAC)
Young Scientist Programme
Innovate India Platform
Innovation Cell

National Statistics Day
Children’s Science Congress

PRELIMS COMPLETE REVISION TESTS
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Imprint Il

o Bharatnet Covers 1 Lakh Gram

Panchayats

National Viral Hepatitis Control
Program

o National Biopharma Mission
o Agmark online system
o World Intellectual Property

Organization (WIPO) treaties

National Intellectual Property (IP)
Award 2018

Intellectual Property Rights Mascot

o Gl Tag

India to expand polar research to
Arctic

o Deep Ocean Mission (DOM)

Chai Sahay App by Tea Board of
India

o MISCELLANEOUS

Glass Fibre Reinforced Gypsum
Concrete

EyeROV TUNA India’s fi rst
underwater robotic drone handed
over to NPOL

Nobel Prize 2018

Prof SN Bose 125th Anniversary
Stephen Hawking

Raman Effect

Li-Fi

Vaterite

Impact Based Forecasting
Approach

o India’s fi rst engine-less train
o Other Scientifi c Achievements in

India in 2018

o Dry Sorbent Injection (DSI)
o Microcystallites
o SARAS
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o Silver Copper Telluride o New Element with Magnetic

o lceVll Properties Discovered
Indian National Centre for Ocean

o 2019 - International Year of Information Service (INCOIS)

the Periodic Table of Chemical
Elements

PRELIMS COMPLETE REVISION TESTS
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Polity Revision Test 1

TEST: 15 (Complete Polity + Current Affairs)

Polity Revision Test 2

TEST: 16 (Complete Polity + Current Affairs)

History Revision Test

TEST:17 (Complete History + Art and Culture of India)

Geography Revision Test

TEST: 18 (Complete Geography + Current Affairs)

Environment Revision Test

TEST: 19 (Complete Environment + Current Affairs)

Economy Revision Test

TEST: 20 (Complete Economy + Current Affairs)

Science & Technology Revision Test

TEST: 21 (Complete Science & Technology + Current Affairs)

TEST: 22 Mock 1 (Paper 1)
TEST: 23 Mock 2 (Paper 2 : CSAT)
TEST: 24 Mock 3 (Paper 1)
TEST: 25 Mock 4 (Paper 1)

TEST: 26 Mock 5 (Paper 2 : CSAT)

TEST: 27 Mock 6 (Paper 1)

TEST: 28 Mock - 7 (Paper 1)

TEST: 29 Mock - 8 (Paper 2 : CSAT)

PRELIMS COMPLETE REVISION TESTS
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TEST: 30 Mock - 9 (Paper 1)

TEST: 31 Mock - 10 (Paper 1)

TEST: 32 Mock - 11 (Paper 2 : CSAT)

TEST: 33 Mock - 12 (Paper 1)

TEST: 34 Current Affairs (Economic Survey + Budget + IYB)
TEST: 35 Mock - 13 (Paper 1)

TEST: 36 Mock - 14 (Paper 1)

TEST: 37 Mock - 15 (Paper 2 : CSAT)

TEST: 38 Current Affairs (May + June, 2020)

TEST: 39 Current Affairs (July & August, 2020)

PRELIMS COMPLETE REVISION TESTS




